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Overview 

The Web-based Temporal Analysis System (WebTAS) is a flexible, extensible, 
problem solving, and systems integration platform.WebTAS can help an 
organization manage, harmonize and exploit all of the disparate systems in their 
enterprise

Module Objectives

After completing this module, participants will be able to:

• Explain what WebTAS does

• Explain when/why WebTAS is used

• Explain the relationship between WebTAS and its business layers

• Define basic WebTAS terminology

• Explain how WebTAS works with data

o Explain what the WebTAS native database is and how it interacts with 
external sources

o List several types of external WebTAS data sources

o Explain how WebTAS consolidates real-time data from numerous sources

• Find help and the user guide

• Describe and use the three display modes
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1.1 What is WebTAS? 

WebTAS is a government-off-the-shelf (GOTS) product with a lineage traceable 
back to 1988. Owned by the Air Force Research Laboratory (AFRL) Information 
Directorate (IF), WebTAS is a program of programs funded by various 
government customers and managed by ISS

The WebTAS product is provided to government customers without explicit 
licensing or support fees (it’s “free”).

WebTAS is a dynamic suite of software tools that provide access, visualization, 
trend analysis, and event prediction capability.

1.1.1  Why use WebTAS? 

WebTAS can represent an enterprise’s disparate (“stovepipe”) systems, databases 
and interfaces using a simple set of abstractions. WebTAS can integrate an 
enterprise’s systems, can visualize and interact with an enterprise’s information in 
a variety of ways.

WebTAS lets you work with data from many different sources as if you are 
looking at one database.

In practical terms, this means that WebTAS can compare and contrast a very wide 
variety of information—and WebTAS displays that information in a virtually 
unlimited number of custom geographic and temporal combinations, each defined 
by you. These flexible displays give you scenario playback, historical analysis, 
pattern discovery, collaboration, and project management capabilities.

WebTAS supplements its powerful data polling, consolidation, and visualizing 
functions with modeling and temporal analysis features that match data to patterns. 
Successful matches result in historical and near real-time situation assessments, 
predictions, and alerts.

1.1.2 Where is WebTAS Used? 

WebTAS has been successfully used in a variety of application areas, or domains.



 
1 WebTAS Overview 
WebTAS Training v3.3.2 • 17 February 2009 

1–4 
 

 Some of the areas that WebTAS has been used in include:

• Strategic C2 

• Counter-narcotics

• Counter-terrorism

• Deception and Denial

• Exercise Scenario Generation

• Combat Operations

• Criminal Investigation

• Fraud Analysis

1.2 WebTAS Business Layer 

You may be using WebTAS by itself or as the driver beneath another application. 
Such applications are often called "business layers" that sit on top of WebTAS. 
Business layers provide preloaded queries, views, temporal models, wizards, and 
so on—making them a shortcut to ramping up and using WebTAS in a custom 
environment. 

Examples of business layers being developed for WebTAS include the following: 

• Master Air Attack Plan Toolkit (MAAP Toolkit) 

• Air Refueling Toolkit (ARTK) 

• Air Force Installation CommandSystem (AFICS) 

• Enhanced SIGINT Tactical Assessment Environment (ESTATE) 
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1.3 Basic Terminology 

We will discuss the following commonly used WebTAS terms:

• Domains

• Object Classes, Attributes, and Instances

• Semi-Natural Language (SNL)

• Projects

1.3.1 Domains

A domain defines the logical data objects manipulated by the WebTAS tools. 

Sample domains could include:

• Counter-drug Domain—with objects of interest like:

o Air and Maritime Tracks

o Seizure Events 

o Clandestine Airfields 

o Suspect Businesses

o Drug Organizations

A WebTAS domain consists of the following information:

• Mappings to JDBC databases and data sources

• WebTAS native database structures

• Object accessible via data source plug-ins

• Behaviors for Business Logic Layer
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The WebTAS domain can be modified without code changes via the Domain 
Editor. WebTAS domains are stored in a Data Dictionary, an XML file commonly 
referred to interchangeably as the domain. The Data Dictionary is saved with the 
extension *.wtdd.

1.3.2 Classes, Attributes and Values

Class—A queryable, manipulable entity in a WebTAS domain.

Attribute—A single characteristic of a Class, e.g., a “Person” class may have 
attributes “Name”, “Age”, and “Gender.”

Value—An instance of an attribute e.g. “Gender” has a value of Male.”

Figure 1–1  Class, Attribute, and Value

1.3.3 Semi-Natural Language (SNL)

SNL is WebTAS’ query language. SNL provides an abstraction layer between the 
user and the data source. All queries developed by the user use SNL regardless of 
the actual data source. Users only have to learn the SNL syntax and that is mostly 
clickable entries.

Users create queries by specifying a set of objects and constraining the attribute 
values.

SHOW Communication WHERE Source = ‘Joe’ AND Destination = 
‘Jeff’

The preceding query uses the object Communication and constrains the attribute 
Source with the value Joe and the attribute Destination with the value Jeff.

WebTAS has numerous constraint operators including:

• Equality operators (Equal/Not Equal, In/Not In)
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• Spatial operators (Inside/Outside/Intersects AOIs, Distance)

• Temporal operators (Before, After, Since, Day of the Week, Time)

1.3.4 Projects

Projects define an individual workspace typically related to an analysis task. 
Projects define views into the data and how the data is displayed. Projects support 
multiple data views. When a project is opened the queries that created the views 
are run causing the project to be updated with the latest information. 

A project is always associated with a particular domain. Projects are saved as XML 
files so an analyst can have multiple projects and share them with other analysts.

1.4 WebTAS and Data

WebTAS provides a framework for consolidating and accessing all relevant 
information from a single application suite.

Types of data sources include:

• Persistent data sets—including relational databases, Excel spreadsheets, 
XML data, and many others.

• Streaming data feed—real-time or near real-time data sources.

• WebTAS database—provides a centralized repository for archiving 
information.

• Proprietary data sets—accessed via a plug-in.

Every installation of WebTAS must have a WebTAS Default Database.



 
1 WebTAS Overview 
WebTAS Training v3.3.2 • 17 February 2009 

1–8 
 

1.5 Getting Help

Help is available in two ways for WebTAS, via the Project Tool Help menu and by 
navigating to the docs directory in the WebTAS install directory structure. The 
following documents are available in HTML format or PDF format:

• WebTAS User Guide

• WebTAS Installation and System Administration Manual (ISAM)

• Security Manager Guide

• Domain Editor Guide

• WebAPP Guide

1.6 Display Modes

When you create multiple views, getting them arranged on screen so that you can 
see what you want can be a challenge. Furthermore, if you open multiple Project 
Tools, and each contains multiple views, the number of view windows for you to 
manage can quickly accumulate.

To help address these challenges, WebTAS provides the display options described 
in the following sections. To find an option that works well in your environment, 
the best approach is to enable each option in turn, and then manipulate (drag, 
minimize, maximize, resize, scroll, and so on) windows to see how they 
behave.WebTAS supports three display modes, Windows, Docking, and Desktop.

The default display mode is the Docking mode which can be changed in the 
webtas.client.properties.3.X.0.0 file.
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Change Display Mode value in the line displayMode=Docking to Windows 
or Desktop to change the default value of the startup display.

1.6.1 Windows

To set the Project Tool to windows mode, choose Window > Window Mode > 
Windows from the pull-down menus. 

Windows mode is similar to desktop mode except the Project Tool is auto-
maximized so that it frames your entire workspace. You can even see "through" 
the Project Tool to your desktop background.

As in desktop mode, if you minimize the Project Tool, it takes all your views with 
it. Non-WebTAS windows, and certain tools such as the Query Panel or Project 
Manager, remain unaffected. However, in windows mode everything (Project 
Tool, views, non-WebTAS applications) gets individually attached to the 
Windows Start bar. 

Figure 1–2  Windows Mode

Windows mode usually gives you more view display space than desktop mode, 
although the line between your WebTAS and non-WebTAS programs becomes 
less obvious. (If you are running more than one Project Tool, things get really 
confusing.) Windows mode is also much more effective than desktop mode when 
your workspace is distributed across multiple monitors.
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1.6.2 Docking

To set the Project Tool to docking mode (the default), choose Window > Window 
Mode > Docking from the pull-down menus. 

Docking mode is the only mode where you can drag, or float, a view outside the 
boundary of its Project Tool. The docking feature also lets you "snap" a view 
window into the surrounding Project Tool frame. You can even dock multiple 
views into the frame to create a tabbed workbook-like display as shown below

Figure 1–3  Docking Mode
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Figure 1–4  Workbook Window and Controls

The right-click menu and window controls let you configure for tabbed 
workbooks, floating view windows, floating tabbed workbooks, and combination 
effects. Experiment with the controls to create the layout that works best for your 
situation. 

Docking mode keeps multiple views neatly arranged and reduces clutter. It also is 
the most flexible display mode for managing a very large number of views. 

1.6.3 Desktop

To set the Project Tool to desktop mode, choose Window > Window Mode > 
Desktop from the pull-down menus.

In desktop mode, all views are bound by the surrounding Project Tool window and 
cannot be dragged outside of it.
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Figure 1–5  Desktop Mode

If you maximize, minimize, or otherwise affect the Project Tool window, it takes 
all your views with it. If you only minimize views, they are minimized within the 
Project Tool window. 

Most users of desktop mode size the Project Tool window large enough to 
rearrange or work with views inside its boundaries. This is usually a fairly easy and 
intuitive process provided that the number of views is small. If not, the Project 
Tool window is scrollable, so you still have the option to arrange views in a stack, 
where you scroll up or down to get to the desired view. 

One advantage of desktop mode is that it does a relatively good job of isolating 
your WebTAS work from any non-WebTAS applications you may be running. If 
you are running more than one Project Tool, they also are reasonably well isolated 
from one another. 

INSTALLATION EXERCISE

In this exercise you will install the WebTAS Client:

To install the WebTAS client software, follow these steps: 

1. Shut down any other programs that are running. 

2. Insert the WebTAS DVD. 
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Your system may be configured to automatically run the disc when you insert it. If 
it does not, manually run the following setup executable: 

{dvd-drive}:\setup.exe 

The initial installer dialog appears.

Figure 1–6  Initial Installer Dialog

3. Click Next. 
The Choose Installer Settings dialog appears. 
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Figure 1–7  Choose Installer Settings Dialog

4. Accept the defaults or specify new directories. Click Next.
The Choose Shortcut location dialog appears.

Figure 1–8  Choose Shortcut Location
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5. Accept the default settings.
The Collaboration Setting Dialog appears.

Figure 1–9  Collaboration Setting

6. If a collaboration server exists, populate the fields, otherwise click Next.
The Pre-installation Summary appears.
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Figure 1–10  Pre-Installation Summary

7. Click Install after reviewing the settings.
The Install Complete dialog appears.

Figure 1–11  Install Complete
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8. Click Done.

For more detailed installation instructions see the WebTAS ISAM.

To install the WebTAS documents, copy the docs directory from the DVD to the 
WebTAS\docs directory.
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2 Working with Queries 
Module Time: 30 minutes
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Overview 

WebTAS provides users with the ability to query the data sources attached to the 
domain. The results of these queries can then be displayed in different types of 
displays or views. This module will focus on creating and maintaining the queries, 
the customizing of the views will be covered in another module.

Module Objectives

After completing this module, you will be able to:

• Explain query syntax

• Define query terminology (e.g., object classes, attributes, values)

• Explain different types of query formats 

• Use the Query Panel

• Open an existing query

• Build a new query

• Manage queries

• Modify a query

• Save a query

• Refresh a query

• Edit a Query
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2.1 What is a Query? 

The process of retrieving and displaying data. WebTAS queries provide the ability 
to exploit the data and answer analytical questions quickly and effectively. 
WebTAS’ query language is called Semi-Natural Language (SNL). 

Query results can be sent to the various WebTAS data visualization displays to: 

• Support Situation Awareness

• Identify trends in target’s behavior

• Identify obscure relationships among individuals, organizations, and events

2.1.1 Structure of a Query

WebTAS data objects come in the form of classes, attributes, and actual values. 
When WebTAS displays objects (for example, in query results), each object is a 
member of a class—and its class determines the attributes and values you get to 
examine. For example, a person object may have a "hair" attribute and "blond" 
value, but an airbase object will not have a hair attribute at all. 

To create a query, you have to identify the object class, attribute, and value of the 
data you are looking for:

SHOW {Object} Where {Attribute} {=} {Value}

The items in braces are things you select with the mouse and are sometimes 
referred to as tokens. WebTAS automatically inserts the words “SHOW” and 
“Where” in and queries.

The object is a user-defined type; the attribute is a characteristic of that object, and 
the value is the specific kind of attribute. For example, assume that you want to 
create a query using the following information:

• Object = cars

• Attribute = color

• Value = white
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The query statement would be:

SHOW cars Where color = ‘white’

The query would return all white cars in the database.

The query panel displays a green checkmark to the right of the query statement 
field when the query is syntactically correct.

Note
A syntactically correct query will not necessarily return 
any results.

2.2 Query Panel Tour 

The Query Panel lets you retrieve only the data that you want to see and direct it to 
various displays such as maps, timelines, tables, graphs, and grids. You create 
queries with logical objects that abstract the physical layout of the underlying 
database and the complex relationships among the tables. Queries can also include 
sophisticated filters such as area of interest (AOI), distance calculations, and 
temporal comparisons. 
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Figure 2–1  Query Panel

The Query Panel lets you construct custom queries against available databases 
using Semi-Natural Language (SNL) statements. You assemble statements in 
point-and-click fashion so that typing SNL syntax is not necessary. 

You may need to enter certain values using the keyboard, but other free-form 
typing is not supported—the Query Panel forms statements strictly via token 
completion. 

2.3 Semi-Natural Language

As you build a query with the mouse, the Query Panel displays an evolving SNL 
statement in a field in the lower portion of the dialog. For example, appropriate 
keywords such as SHOW and Where are automatically added to the statement. 

SNL is based on standard SQL syntax, but it keeps you from having to know SQL 
and is more readable. When you send a query by clicking the Query button, 
WebTAS transparently converts the SNL into SQL and submits it to the database 
for processing. 

WebTAS also uses SNL to define views into the data from the WebAPP and to 
describe objects in a Model Developer pattern 
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2.4 Comparison Operators

The comparison operator buttons change based on the selected attribute data type.

Figure 2–2   Comparison Operators

Creating a Query

1. Select an object class. Note that you can run the query even if you stop here; 
the results simply reflect all such objects in the database.

2. Select an attribute. The list of attributes is automatically customized based on 
the object

3. Click a comparison operator button

4. Enter a value for your selected attribute. The Value Entry frame is 
automatically customized based on the attribute. For example, if you selected 
a date attribute, a value field for inputting the date, time, month, and year 
appears. 

5. Click the OK button to add the attribute value to the query. 
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6. (Optional) Add more conditions to the query by using the logical operator 
buttons and repeating the attribute, operator, and value process. 

7. Use the drop-down menu to point the results to one of the available views. 

8. Set display options, and click the Query button. 

Figure 2–3  Query Panel Walk Through

2.5 Using Variables In Queries 

Variables may be established in a project created by a user. They may be used to 
name value entries or to generate dynamically changing values. A user created 
variable will be available in that project only, and is not saved to the domain. 

Create a Variable

1. Select Project > Set Project Parameters
The Edit Variable Specifications window opens.
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Figure 2–4  Edit Variable Specifications

2. Specify a Name 

3. Specify a Data Type

4. Specify a Value

5. (Optional) Select Always Prompt
If selected the Edit Variable Specification window will always open upon 
starting your project, to allow you to modify the variable value.

6. Click Add

To use a variable in a query, build a WebTAS query in the Query Panel to the point 
of value entry. Click the Variable button at the upper right corner of the value entry 
area and select the variable from the drop down list. WebTAS variables are 
identified by the “$” that precedes the name. 
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2.6 The Attribute Selector 

The Attribute Selector is a tool that may be used to build more precise queries. To 
do this, specific attribute values are selected from the range represented in the 
database to use in the query. A separate query panel window is opened when using 
the Attribute Selector. WebTAS will not check to see that attributes are of the same 
type, so it is possible to build queries that cannot have any returned records. 

Click the Picker button (see figure 2–5) to open the Attribute Selector. 

Figure 2–5  Picker

This will open a supplemental query panel window that will be used to build a sub 
query. When a valid query has been built using the standard WebTAS SNL query 
building procedures, select the Get Objects button at the bottom right of the 
window. 

This will populate the objects field with a record identifier for each data record that 
matched the sub query constraints. 

Clicking on a record identifier will populate the attributes window with the data 
from that record. An attribute from this list may be selected to be used in the 
original query. There are two options when using the attribute:

Value—inserts present value of the selected attribute into the query.

Reference—acts as a pointer to the data in that attribute; if that data later changes, 
the results of the query will change when run to reflect the changes in the base 
data. 

Pressing the Select button will add the results of the Attribute Selector query to the 
value entry box in the main query. That value may then be added to the query in 
the same manner as typical values. 
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Figure 2–6  Attribute Selector

2.7 Complex Queries

Logical operators AND, OR, and parentheses allow you to combine multiple 
constraints in a single query. 

For example, you could query for Aircraft events as follows: 

Altitude > ‘15,000 feet’ AND Aircraft Type = ‘B-52’ 
Altitude > ‘15,000’ feet AND (Aircraft Type = ‘B-5’2 OR 
Aircraft Type = ‘B-1B’) 

Be aware of precedence in operators. Most queries are not overly complicated, and 
precedence is not an issue; however, it may be important to track the nesting of 
parentheses for complex queries. The rule of thumb is similar to 
mathematics—work parentheses from the inside out. Within the same nesting 
level, perform AND operations first, then OR. You can position the cursor (press 
the forward and back arrow keys) in the SNL query statement line to add and 
remove parentheses for proper nesting. 
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2.8 AOI Button

If you click the “Area of Interest” (AOI) button while building a query the attribute 
list only displays those attributes that have location data. If you want to combine an 
AOI query with other attributes in a complex query, select the AOI button as the 
last part of your complex query.

Figure 2–7  AOI Button Results

2.9 Visualization

Query results may be visualized and manipulated via:
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• Maps

• Timetables

• Timelines

• Graphs

• Charts

• Grids

• Link Charts

• Tables

After you create the query, select where to send the results of the query.

The drop down menu in the lower right of the Query Panel lets you direct output to 
the desired view type. Typically, you can send results to a view that is already open 
or to a new view. Using an already open view can prove useful if you need to see 
new objects in relation to old ones, in the same context. The object type in your 
query can limit the available views. For example, if an object class does not 
contain a location attribute, you cannot send the results to a map. Likewise, an 
object without a Date or Daterange attribute cannot go to a timeline. 

If there are any active views they will be listed below the default values and 
separated by a line.
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Figure 2–8  View Output Drop-List

Note
Only Maps and Timelines can be the target of multiple 
queries 

2.9.1 Specify Display Properties

After you have created your query and selected what type of view is to be used to 
display your query, you must specify what display properties WebTAS should use 
to display queries of the selected class in the selected view. 

The first time that you create a query for a class and specify the view for that query 
WebTAS does not know how you want the query displayed and you must use the 
wizard to create display properties. If you save your choices, the subsequent time 
that you query a class and specify the same view type your saved display 
properties will be the default properties and you do not have to use the wizards 
unless you want to change ho your query is displayed.
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2.10 Open and Save Queries

You can save a query that you have created by Clicking the Save button. A 
Windows Save Dialog opens allowing you to name and save your query. To Open 
an existing query, click the Open button and select the query to open.

2.11 Editing Queries

You can edit an open query with the buttons to the right of the Query button: 

• Clear—Empties the Query Panel of all selections so that you can start over. 

• Delete—Erases the query statement, one step at a time, in reverse order. 

• Undo—Backs out of your specific steps when using the Query Panel, 
whatever those steps may have been. 

You can edit the SNL query statement directly in any of the following ways: 

• Replace—To replace a token, double-click it in the SNL statement (which 
turns it red). The focus of the Query Panel goes to the place where you 
originally selected the token. Select a new one to substitute it for the one that 
you double-clicked. 
If you replace the original object, WebTAS clears the remainder of the query 
(the constraints clause). 
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• Add—To add a condition, click or use the arrow keys to navigate to the 
desired place in the SNL statement. If a syntactically legal addition can be 
made at that point, a blinking cursor appears. 
WebTAS then enables allowable selections in the attribute or operator lists. 
You can add to the statement in the same way that you created it—by putting 
new tokens in place. Just as with the original statement, the green check 
appears when the added tokens create a syntactically valid query. 

• Remove—To remove a token, double-click it in the SNL statement (which 
turns it red), and click the Delete button. WebTAS removes the selected token 
and a blinking cursor appears to allow you to insert a new condition. 

If no new condition is needed, edit the remainder of the statement so that it 
becomes valid. For example, if an OR was after the removed condition, you must 
also delete the OR. 

2.11.1 Wildcard

You can specify text attribute values by entering the string into the specification 
area. Be aware that some databases are case sensitive. Wildcards (*) are allowed. 

For example:

 Show FACILITIES where FACILITY_TYPE = 'D*' 

results in all facilities that start with "D." 

Note
If you specify only a portion of the full value, you must 
use wildcards in the string to ensure results. Without 
wildcards, WebTAS assumes that the specified text is the 
entire value expected and may not return any results. 

EXERCISE: CREATE A QUERY

1. Open Project Tool using accesscolombiademo.wtdd

2. Create a query to show kidnappings

3. Save your query
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4. Edit the query to constrain the query to kidnappings which occurred on or 
after Feb. 01 2002 00:00

5. Save your query.

6. Edit the query to constrain the query to kidnappings which occurred before 
Feb. 01 2002 00:00

7. Save your query.

8. You will use these queries in the next module.
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3 Using Tables 
Module Time: 1 hour
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Overview 

Tables are displayed as a collection of rows and columns and are similar to the 
traditional spreadsheet view. A table is useful for quick evaluations. If the results 
look valuable, you can post the same query to a more complex and appropriate 
view. Tables are also a good way to become familiar with the available data. For 
example, you might want to query for individuals and view them on a map, but you 
first need to know if any individuals are in the database. 

Module Objectives

After completing this module, you will be able to:

Use the Table Properties window to:

• Select column headings

• Set cell coloring

• Set row coloring 

• Select the Time Scroll attribute

• Specify Quick Filter elements

Resize columns and rows

Rearrange column order

Sort columns in ascending or descending order

Use the right-click menu to configure column visibility

Use the right-click menu to view subtables

Explain functions available via the right-click menus
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Open a database record

3.1 Table Configuration 

When a query is sent to a table view for the first time, the Table Properties window 
is opened. This window contains five tabs used to configure the table view. The 
following sections cover the use of the five tabs. 

3.1.1 Table Tab 

The Table tab is where you select which attributes appear as column headings in 
your table view. The available attributes are listed in the left panel and the 
attributes that will appear as column headings are listed in the right panel. 

Available attributes can be added to the Selected Attributes list by clicking the 
attribute in the Available Attributes list. Attributes can be removed from the 
Selected Attributes list by clicking the attribute in the Selected Attribute list. 

When you have customized the Selected Attribute list to your needs, you can save 
the settings by clicking the Save button at the top of the wizard.
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Figure 3–1  Table Tab

3.1.2 Cell Coloring Tab 

The Cell Coloring tab lets you select an attribute to color-code a cell. 

To color-code a cell by attribute:

1. From the Attribute drop-down menu, select the attribute to color-code. 
A value field appears.

2. From the Select a Value list (blue finger icon), select a value.

3. Click the Add button to add the attribute/value pair to the list of constraints.

4. Click in the BG Color field, and select a color to modify the cell background 
color.

5. If desired, click in the FG Color field, and select a color to modify the text 
color.

6. If desired, click the Save button to save your changes as the new default 
configuration.

7. Click OK to create/refresh the table view.
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Figure 3–2  Cell Coloring Tab

3.1.3 Row Coloring Tab 

The Row Coloring tab lets you select an attribute to color-code a row. The process 
for coloring a row is the same as for coloring a cell. 

Additional options available under the Row Coloring tab include:

• Take Priority over Cell Coloring—by default, cell coloring takes priority 
over row coloring; this checkbox enables you to change that configuration.

• Alternate Row Colors—checking this option will shade alternate rows to let 
large tables be read more easily.

• Constraint ordering buttons—you can reorder the row coloring if there is 
an overlap of colors; this option lets you configure the view to your liking.
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Figure 3–3  Row Coloring Tab
 

3.1.4 Time Scroll Tab 

The Time Scroll tab also displays the Available Attribute and Selected Attribute 
panels. Selecting an attribute is optional. The selected attribute is used to 
synchronize the table view with other views that have a similar Time Scroll 
attribute set. The synchronization process is performed in the Project Manager 
window, but only views that have similar Time Scroll attributes selected can be 
synchronized. 
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Figure 3–4  Time Scroll Tab

3.1.5 Quick Filters Tab 

WebTAS uses the Query Panel to filter all of the data available (see Figure 3–5) to 
create a view of only the information that is meaningful for your task. However, 
after a view is created, you can further filter the subset of data by using quick 
filtering. The attributes added in this view will be available when you choose to 
display Quick filters.
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Figure 3–5  Quick Filters Tab

EXERCISE: SHOW KIDNAPPINGS ON A TABLE

1. Show Kidnappings on a New Table

2. Display the following columns:

• Event Date

• Number Kidnapped

• Ransom Demanded

• Responsible Group

• Victim Type

• Guerilla Units

• Status

3. Turn on alternate row coloring

4. Set Status and Responsible Group as Quick Filters
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5. Save your display settings as Kidnapping Table

3.2 Reorganizing a Table 

Although the Table Properties window is used to select which attributes are 
displayed in the table and any cell or row coloring applied, there are additional 
features that you may customize from within the table itself.

You can make the following adjustments to a table:

Resize columns

Resize rows

Reorder columns

Sort rows

To resize columns:

Click and drag at the right-hand boundary between column headers.
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To resize rows:

Click the desired row resizing button. 

To reorder columns:

Click and hold the mouse cursor on the column header, and drag the column 
left or right.

To sort rows:

To sort table rows based on the alphanumeric or temporal order in a column, 
ctrl + click the header of a column. An up arrow appears next to the header 
title, and the rows get sorted top to bottom based on the values in that column. 
Click the same header again to show a down arrow and sort the rows in 
reverse order. A third click will return the column to the original order.

Nested row sorting is possible by first clicking one column, then the next, and 
so on. The last column clicked becomes the primary sort attribute, followed 
by the next to last, and on backward as indicated by numbers. 

3.3 Right-Click Menus 

 If you right-click in a table, a right-click context menu appears. The menu displays 
options specific to the area clicked. 
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The three areas that open a context sensitive right-click menu are:

Column heading

Row

Cell

Column Heading Right-Click Menu

Right-clicking a column heading opens a menu containing two or three parts:

List of all attributes available as column headings—the attributes with a 
checkmark are the current column headings displayed. Unchecking a heading 
hides the column from view but does not remove the column from the query results

• Edit Properties Option—opens the Table Properties wizard, and allows all 
of the options listed in the Table Configuration section

• Reset Column Order—available only if any columns have been reordered.
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Row Right-Click Menu

Right-clicking a selected row opens a menu containing many options. To select a 
row, click in the row number column.

For a complete explanation of the options see the WebTAS User Guide.

Cell Right-Click Menu

The cell right-click menu is a subset of the row right-click menu.

3.3.1 Using Quick Filters
To use Quick Filters: 

1.  Create a view. 

2. Open the quick filter pane (right-click > Quick Filter). 

3. Under the Add Filters section, select a filter attribute from the drop-down 
menu. 
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4. Click the Add button. 

5. Under the Filtering section, enter or identify the specific values that you want 
to allow through the filter. 

6. Click the Refresh button to redisplay the view with only the desired results. 

7. Note that the Refresh button includes an asterisk (*) whenever the view 
display has not been refreshed to match the current quick filter settings. 

8. You can add more than one filter; however, WebTAS limits the total number 
of filters to five. 

9. Closing the Quick Filter—To close the quick filter, right-click in the view, 
and reselect the Quick Filter option. 

Figure 3–6  Quick Filters

The process for using Quick Filters is the same for any view. Figure 3–6 shows 
Quick Filters on a Map. 
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3.4 Working with Records

Viewing a Record

1. Double clicking a row in a table opens the database record associated with 
that row. The record opens in a WebTAS data browser window.

Figure 3–7  WebTAS Data Browser

Deleting a Record

When you want to delete a record in the WebTAS Default Database:

1. Send the records to a table.

2. Select the record or records (CTRL+ click to select multiple).
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3. Right-click the record and select Delete.
You will be prompted to ensure that you really want to delete the record.

Modifying a Record

When you want to modify a record in the WebTAS Default Database:

1. Send the records to a table.

2. Select the record to modify.

3. Right-click the record and select Modify.
The Modify Record window opens.

Figure 3–8  Modify Record

4. Make your changes and Click the Modify button.

Add a Record

1. Edit > Add New Record
The Add Records window opens.
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Figure 3–9  Add Records

2. Navigate to the type of record you want to add.

3. Complete the desired fields.

4. Click the Add button.
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4 Using Maps 
Module Time: 2 Hours
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Overview 

A map displays objects in geographical context with other objects. A map includes 
information such as land and water masses, political borders, and latitude (lat.) and 
longitude (lon) scale. The map view is one of the most commonly used views and 
one of the two views-timeline being the other-that can contain the results from 
multiple queries. 

Module Objectives

After completing this module, you will be able to:

Explain that maps display data in a geographical context

Set map label properties

Edit properties

Change scale

Change properties

Show objects

Hide objects

Copy location to clipboard

Add a map layers

Manage layers

Create or overwrite an Openmap properties file

Draw on a map

Highlight location points

Run travel calculations
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View AOI Boundaries

4.1 Creating a Map 

A map displays objects in geographical context with other objects as seen in Figure 
4–1. A map includes information such as land and water masses, political borders, 

and latitude (lat.) and longitude (lon) scale. 

Figure 4–1  Map View

Objects must have a location-based attribute such as "event location" in order to 
appear on a map. 

To create a new map view: 

1. Build a valid query using the Query Panel.

2. Choose the Send Results to New Map option. 
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3. Choose named display properties from the drop-down menu in the lower left 
corner of the Query Panel. Alternately, choose the Specify Properties option 
to configure new or first-time display properties. 

4. Click the Query button.

For named display properties, the new map automatically appears. 

Otherwise, WebTAS opens the Map in the Edit Mode. 

You also have the option to create a blank map with the toolbar button or by 
choosing File > New > Map from the pull-down menus. You can add content to 
the blank map using the Project Manager. 

4.2 Edit Mode

When you send a query of a class to a Map and select Specify Properties, the Map 
view opens in the Edit Mode. 

Use the Edit Mode mode to define the following properties:

• Queries 

• Shapes 

• Time Scrolling 

• Quick Filtering 

We will discuss defining Shapes in this course, for complete information on 
defining Map properties refer to the WebTAs Project Tool Guide. 

Using the webtasdemo-access.wtdd file we will send a query to a Map View and 
configure how we want to see the query displayed.

Show COMMUNICATIONS on a MAP

1. Create the query and click the Query button.
The Map opens in the Edit Mode.
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Figure 4–2  Map in Edit Mode

Note
All of the icons are the same based on the display 
properties in the Data Dictionary. We will edit these 
properties and save them in the Display Properties 
directory under C:\Documents and Settings\local 
user\WebTAS\DisplayProperties

2. Select the icon in the Shapes panel on the left side,
The lower right hand panel becomes the Icon Features configuration panel.
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Figure 4–3  Icon Features

3. Select the Image row under Icon Properties.
The Select an Image panel appears.
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Figure 4–4  Select an Image

4. Select the Data Driven Option.
The Data Driven Selection window opens.
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Figure 4–5  Data Driven Selection

5. Select Source from the Attribute drop list.
The Value Picker appears.
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Figure 4–6  Value Picker

6. Click the Value Picker Icon.
The Select a Value panel opens.
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Figure 4–7  Select a Value

7. Select Jose, click OK and then click the Add button.
Jose will be added to the list of constraints.
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Figure 4–8  List of Constraints

Note
Jose and Sunrise have been added to the previous image 
and all three items are using a single icon to represent the 
Communication.

8. Click in the Data Driven cell in the row containing Jose,
The Icon Selection window opens.
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Figure 4–9  Icon Selection

9. Open the Communications folder, select 2.gif to represent Jose’s 
communications and click OK.
The appropriate icon is displayed in the Data Driven cell.
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Figure 4–10  Icons Selected

Note
The Icons have been updated for Jose and Sunrise.

10. Click OK.
The Icons are updated on the Map Edit Mode
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Figure 4–11  Updated Icons

11. Click the Label Properties tab.
The Icon Labels panel appears.
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Figure 4–12  Icon Labels

12.  Select the (not set) property in the Text line.
The Select Attributes for the Text panel opens to the right.
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Figure 4–13  Select Attribute for Label

13. Select the Date attribute as the label.
The labels appear on the Map display.
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Figure 4–14  Labels

14. Select the Show Communications query in the Queries panel.
The Lower right hand panel now displays the Show Communications Display 
Properties.
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Figure 4–15  Save or Load Display Prioerties

15. Click Save to save the Display Properties as Communications Map.
If you wish to use a different name, edit the Name field to a display name of 
your choosing.

EXERCISE: SHOW KIDNAPPINGS ON A MAP

1. Show Kidnappings on a Map

2. Use Number Kidnapped as the label

3. Use Data Driven icon

4. Set Political Hostage–Red hostage icon

5. Set Religious Hostage–Green hostage icon
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6. Set Default Hostage–Blue hostage icon

7. Save your display settings as Kidnapping Map

4.3 Toolbar Buttons

Map navigation involves options that are distributed across a toolbar, a pull-down 
menu, and a right-click menu. Some options are available in multiple places. 

Toolbar—WebTAS enables the buttons in Table on the toolbar whenever a map 
view is active. Note that there are copies of the toolbar buttons on the view window 
itself. You can detach those buttons or dock them on any side of the view by 
clicking and dragging. 

Table 4–1  Toolbar

Button Option Description

Enable Select Mode Allows you to select objects on a map: 
Select a single object by clicking. Select 
multiple objects with Shift+click. Select a 
group of objects by holding down the 
mouse button and dragging a rectangle 
around them

Enable Track Point 
Select Mode 

Allows you to select individual track points 
(without selecting the entire track) by 
holding down the mouse button and 
dragging a rectangle around them 

Enable Navigation Mode Allows you to set a new center position by 
clicking. You can also specify a zoom area 
by holding down the mouse button and 
dragging a rectangle. 

 Enable Pan Navigation 
Mode

Set a new center position by clicking a map 
and holding down the mouse button while 
dragging to a new map location. You can 
also zoom in by clicking the left mouse 
button and zoom out by using the right 
mouse button.
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Zoom  Left Click - Allows you to magnify your 
view (decrease the map scale). The click 
point becomes the new center. 
Right Click - Allows you to increase the 
map scale.

Enable Map Feedback 
Tool Mode

Lets you click a point on the map to see the 
following: Location (for example, lat/lon) of 
the mouse cursor Distance from a clicked 
point to the mouse cursor Azimuth 
(heading) from a clicked point to the mouse 
cursor 
Subsequent clicks on the map adjust the 
center point, and the distance will be a 
cumulative total between all clicks and the 
current mouse position. Azimuth will 
always be relative to the last clicked point 
and the current mouse position. Double-
clicking ends the feedback mode.

Enable Single Point AOI 
Mode 

Lets you specify a location point when 
making a map selection 

Enable Rectangle AOI 
Mode 

Lets you specify a rectangular area when 
making a map selection 

Enable Polygon AOI 
Mode 

Lets you specify an irregular area when 
making a map selection 

Toggle Label Visibility Turns the labels on the map on or off.

Undo Map Navigation Backs out one step of map navigation 
actions you have made..

Maintain Projection Keeps the current zoom scale and center 
point when adding new queries or loading 
properties 

Table 4–1  Toolbar

Button Option Description
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4.4 Using Layers

WebTAS creates the look and feel of a map by layering different visual imagery 
into a composite that forms the final view. In turn, you have control over the 
number and kinds of layers that WebTAS assembles into a map view in order to 
make it suitable for your analysis needs (see Figure 4–16.) 

Figure 4–16  Multilayer Example
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When you send query results to a new map, WebTAS adds three layers by default: 

• Query Results—Object icons that represent the query results 

• Graticule—Location lat/lon grid lines 

• Political Solids—A shape file layer showing solid-color countries of the 
world 

With only the default layers in place, the previous map would look similar to 
Figure 4–17. 

Figure 4–17  Default View
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Note
There are two ways to add layer information to your 
view, the Openmap method and the WebTAS Project 
Manager method. It is strongly recommended that you 
use the WebTAS Project Manager method.

WebTAS Project Manager allows you to add layers to a Map. You can add the 
following layers to a map:

• Legend

• Day/Night Layer

• DTED Layer

• RPF Layer

• Graticule Layer

• Shape File Layer

EXERCISE: ADDING A LAYER

1. Open Project Manager and select the Detail tab.

2. Highlight the Map and right-click or select the Add Query droplist.

3. Select Add RPF Layer.
A warning dialog about Mercator Projection opens
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4. Click Yes.
The Map is reconfigured and the RPF layer is highlighted in Project Manager.

5. Select the RPF Path and navigate to the directory containing your Map Data.

6. Select Opaqueness and adjust the opaqueness to your liking.

7. Reorder the RPF layer and close Project Manager.
Do not close your Map.

Updating the Openmap Properties File

1. With the Select Arrow active Right-click on the map and select Edit 
Properties.
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Note
Ensure that no objects are selected on the map, otherwise 
you will not get the correct Right-click menu.

2. Click the Save Openmap Properties to Disk button.

3. Save a file named openmap.classtest.properties.

4. Test your new file by creating an new empty map.

5. Right-click on the new map and select Edit Properties.

6. Click the Load Openmap Properties from Disk button.

7. Load you openmap.classtest.properties file.

8. Click the Apply button.

9. Click OK.

10. Zoom in to test your new file.

11. Does it look like the other map?

Note
You could have overwritten any openmap.xxx.properties 
file instead of creation a new file. You could also have 
saved your new configuration as the default for all maps.

4.5 Drawing on a Map

You can draw directly on a map with the Annotation Palette.

The Annotation Palette window lets you add text, lines, rectangles, and icons to a 
map. You can add them in any free-form location or position that is important to 
your analysis task. For example, you might add a rectangle and label to surround a 
particular subset of query result objects. 
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To add an annotation, click one of the five buttons at the top left part of the 
Annotation Palette. The button should look like it is pushed down. Then, take the 
cursor directly to a map view. (If you try to annotate a non-map view, you will 
have to start the process over.) The cursor should have a special "+" appearance 
that is different from the standard pointer. 

The button in the top right corner of the dialog opens the tabs that let you tailor the 
appearance of your text, line, rectangle, or icon. 

Figure 4–18  Annotation Palette

4.6 QuickPoint

You can use the QuickPoint dialog to highlight location (for example, lat/lon) 
points on a map. Click the toolbar button or choose View > Show QuickPoint 
Form from the pull-down menus. 
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The QuickPoint dialog is designed so that you add locations to a special table as 
shown in Figure. Enter a name and location at the top of the dialog, and click the 
Add button. For location, you can type coordinates directly or use the point AOI 
function directly on a map. 

After adding points to the special table, you can highlight the desired rows and 
click the button at the bottom to find them on an existing or new map view. 

Figure 4–19  QuickPoint Dialog

The dialog also lets you choose the icon for marking the found locations. Click the 
Map Icon button, and choose a shape from the available folders. 
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4.7 Running Travel Calculations

You can compute distance, speed, time, and direction on a map. The Map Tools 
dialog calculates values based on map location points that you specify. 
Calculations are "as the crow flies" and do not compensate for terrain. 

 Map Tools also let you draw three kinds of features on the map: straight lines, 
great circles, and range circles. 

Figure 4–20  Map Tools Dialogs
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4.8 Viewing AOI Boundaries

When you construct a map location query based on an AOI, you often want to see 
the lines that defined the AOI along with the query results. The following sections 
describe the AOI options that make this possible. 

Making an AOI Boundary Visible 

1. From the menu bar, make sure that View > Draw Polygons on Maps is 
selected.

2. On the toolbar, click the rectangle or polygon AOI tool.

3. On a map view, click to form the AOI shape.

4. In the Query Panel, construct a location-based query that uses the AOI button.

5. WebTAS prepopulates the value area of the Query Panel with the AOI 
location point vertices from step 3.

6. Send the query to an existing or new map.
The lines that form the AOI appear on the view along with the query results 
(see Figure 4–21).
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Figure 4–21  AOI Rectangle
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Overview 

List all components in the active project by opening Project Manager. Click the 
Project Manager button in the toolbar, or choose View > Show Project Manager 
from the pull-down menus. Project Manager opens in a separate window that 
includes information and controls. 

Module Objectives

After completing this module, you will be able to:

Use the Project Manager to modify queries

Synchronize views

Fine tune project formats

Create shape files

Import shape files

5.1 Tour 

In addition to showing you what a project includes, the Project Manager is the 
central place to manage the data and format of all the WebTAS components that 
make up the project: 
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• Views 

• Individual queries 

• Link analysis 

• Dynamic relationship rules 

• Models 

• Historical K-PASA analysis 

In general, you can right-click a component listed in Project Manager to see what 
options are available. There is also a panel of options at the lower left. The options 
are dynamic and will change based on the kind of project component you select. 

You can also double-click any view in Project Manager to bring the view to the 
front of the Project Tool workspace.

Figure 5–1  Project Manager
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5.2 Summary Tab 

The Summary tab provides the central control point for all open views. You can 
add or edit queries, edit view properties, and remove views or queries. You can 
also activate synchronization between views to enable playback of multiple views.

5.3 Details Tab 

The Details tab provides a view into the values associated with the open views. 
You select the view or query that you want to modify and the values that you can 
modify appear in the right hand pane. 

Figure 5–2  Details Tab

Click the value to be changed and use the drop list provided or enter your desired 
value.
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Figure 5–3  Details Tab Right-hand Pane

5.4 Projects Tab

The Projects tab allows you to:

• Add new Projects

• Activate existing projects 

• Manage projects

• Remove projects
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Figure 5–4  Projects Tab

If you activate the project, you can see more details.
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Figure 5–5  Activated Project

5.5 Selection Tab

The selection tab shows additional details about a highlighted item that is not only 
listed in the Project Manager, but from a queried result.

When you highlight a row in a table or click an object on a map, that results in the 
specific details of that row or object being displayed in the Selection tab. This is 
especially useful if you select a point on a map and see the specific details of the 
item.
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Figure 5–6  Selection

5.6 Removing, Renaming, and Refreshing Views

You can remove an entire view by highlighting the corresponding entry in Project 
Manager and clicking the Remove option near the bottom of the window. 

You can rename an entire view by right-clicking the corresponding entry in Project 
Manager and choosing the Rename option 

You can repopulate an entire view with updated data by highlight the view, and 
clicking the Refresh option near the bottom of Project Manager. 
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5.7 Synchronizing Views

Synchronization coordinates multiple views so that scrolling or changing one 
changes the others by the same increments. For example, synchronizing a map and 
a timeline can simultaneously reveal where and when events in your analysis have 
occurred. 

 To synchronize views, Ctrl+click in Project Manager to highlight the views that 
you want to link. Then, click the synchronize symbol near the bottom right corner 
of the window. Synchronized views show a dark connecting line in Project 
Manager (see Figure 5–2). 

 To unsynchronize, Ctrl+click to highlight the desired views, and click the 
unsynchronize symbol near the bottom right corner of the window. 

5.7.1 Playback Controller

The playback controller shown in Figure 5–7 changes the current time frame and 
lets you see the progression of date attribute objects, such as events, in any desired 
fashion. When used on a map, timeline, or graph, playback becomes a very 
powerful means of understanding temporal relationships among objects. 
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Figure 5–7  Playback Controller

EXERCISE: USE PROJECT MANAGER TO ADD A SHAPE FILE TO A MAP

1. Send Kidnapping query to a map.

2. Zoom in to spread out icons.

Open Project Manager to details tab.

3. Select Map view.

4. Add a shape file layer.

5. In ESRI shape properties pane, select the shape file droplist.

6. Navigate to Demos\BadGuyA02.shp and add the file.

7. Select Default Drawing Attributes.

8. Set line color to Red.



 
5 Using Project Manager

WebTAS Training v3.3.2 • 17 February 2009

5–11 
 

9. Set line width to 2.

10. Set fill color transparency to @ 25-30%.

11. How many events are in the area?

12. How many Kidnappings?

5.8 Creating and Exporting a Shape File

Project Tool allows you to both create new shapefiles from data in the database 
and add shapefiles to a map display. For example, you can create a shapefile 
containing all points in the database then have those points rendered on your map 
by adding a shapefile layer to a map.

To create a shapefile and display the created shapefile on a map, do the following:

1. Create a new query as described in Creating a New Query, and send it to a 
view. 

2. From Project Manager, select the query. 

3. Right-click, and select Export > Export to Shapefile.
The Export Manager opens. 
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Figure 5–8  Export Manager

In the tree at the top of the dialog box, the query you chose to export is highlighted. 
If you want to export a different query, you can select it from this tree. In the 
Target droplist, Shapefile Exporter is also selected because you chose to export a 
shapefile. You can also export additional queries after the first. The Export 
Manager remains open until you click the Cancel button.

4. Beside the Filename field, click the Ellipses (...) button. The Save dialog box 
opens. 

5. Browse to the location where you want to save the file, and name the file 
(*.shp). 

6. Click the Save button. The file name appears in the Filename field. 
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Note:
 The Location Attribute field represents the location data 
to use for the export operation. If the selected attribute 
did not represent discrete points, you would have the 
option to export polygons or polylines.

7. (Optional) The Shapefile Exporter creates three files: the shapefile (.shp), a 
metadata file (.dbf), and a shapefile index (.shx). If the you want these files 
contained in a single zip file, select the Create Zip File check box. 

8. Click the Export button. A message opens confirming the export. 

9. Click OK. 

10. (Optional) Create additional shapefiles from the queries in the tree. If a query 
cannot be exported due to the underlying data lacking any location attributes, 
the Export button is disabled. 

11. Click the Cancel button. 
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Overview 

WebTAS has additional views that can be used to display the results of a query. 
They include timelines, timetables, link analysis, graphs and others.

Module Objectives

After completing this module, you will be able to:

Use Timelines

Use Timetables

Use Link Analysis

Use Graphs

Use Grids

Use 3D Maps

Use Google Earth

6.1 Timelines 

A timeline displays objects in chronological context with other objects as shown in 
Figure 6–1. A timeline includes start and end points and a graduated scale. 
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By default, WebTAS frames the timeline view based on the earliest and latest dates 
in the query results. Consequently, the scale automatically displays date 
increments appropriate for including all of the objects. In other words, the scale 
displays whatever timeframe necessary to include the results, be it several months 
of data or only one day. 

Figure 6–1   Timeline

Objects must have a date-based attribute in order to appear on a timeline.

6.1.1 Navigating a Timeline

WebTAS automatically resubmits the query and refreshes the timeline whenever 
you navigate the view by scrolling or modifying other settings. 

Figure 6–2  Timeline Controls
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Timelines display a three-part scale at the top of the window: 

A bar showing the caret "^" character 

An upper scale with larger units of time 

A lower scale with smaller units of time 

To zoom in, click one of the upper or lower scale segments. To zoom out, click the 
bar showing the caret "^" character or right-click in the upper or lower scale and 
click Back.

Figure 6–3  Zooming In and Out

6.1.2 Formatting a Timeline

The Timeline Display Properties dialog (see Figure 6–4) lets you choose attributes 
for the timeline and format their appearance. The wizard is similar to the Location 
Attributes Properties wizard but is tailored toward temporal display instead of 
location.
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Figure 6–4  Timeline Properties

Timelines can display fixed icons, series icons (see Figure 6–5), and set bar colors 
for series (see Figure 6–6).

Figure 6–5  Series and Point Display
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Figure 6–6  Series Bar Output

EXERCISE: SHOW KIDNAPPINGS ON A TIMELINE

1. Show Kidnappings on a New Timeline

2. Number kidnapped as the label

3. Data driven icon by victim type

• Set Political Hostage–Red hostage icon

• Set Religious Hostage–Green hostage icon

• Set Default Hostage–Blue hostage icon

4. Random vertical position between 20 and 80 percent

5. Save your display properties as Kidnapping Timeline
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6.2 Timetables 

Timetables format query results into a combination of table and timeline as shown 
in Figure 6–7. A timetable links temporal context to its related data in the same 
row and lets you manage them together—something that is difficult with a separate 
table and timeline even when their windows are arranged side by side. 

Figure 6–7  Timetable

Unlike normal tables, timetables do not support subtable displays.

6.2.1 Formatting Timetables

In WebTAS business layers, timetables are usually preformatted to suit a known 
analysis or display problem. Such preformatted timetables may contain fairly 
complex formatting relative to the ones you format by hand. 

6.2.1.1 Grouping Rows

The Timetable Display Properties dialog gives you the option to organize rows by 
grouping them. A leading column identifies a grouping attribute that allows you to 
expand or collapse rows that are organized under a master row as shown in 
Figure 6–8.
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Figure 6–8  Timetable Group Column

6.2.1.2 Configuring the Table Side

By default, the Timetable Display Properties dialog opens on the Table tab as 
shown in Figure 6–9. The Table tab lets you select and format the columns needed 
for the table side of the view:

Figure 6–9  Tables Tab

6.2.1.3 Configuring the Timeline Side
To configure the timeline side of the view, do the 
following: 

1. In the Timetable Display Properties dialog, select the Timeline tab. 

2. Click the Add button (see Figure 6–10). 
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Figure 6–10  Adding a Timeline Visual Element

3. In the Select Timeline Visual dialog, highlight a visual element, and click the 
Add button. 
Depending on the visual element, there may be one or more additional 
dialogs to fill in as prompted (see Figure 6–11). These will vary, however. 

Figure 6–11  Additional Dialog 

4. Back in the Timetable Display Properties dialog, use the options in the right 
portion of the dialog (and the preview pane at the bottom) to fine-tune the 
appearance of the visual element. 

5. If desired, repeat starting from step 2 to add more visual elements. You can 
drag and drop visual elements to achieve the appropriate layering. See 
Figure 6–12. 
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Figure 6–12  Timetable Timeline Tab

You can also add more than one of the same kind of visual element. Figure 6–13 
shows two date ranges, an icon, and day/night shading. 

Figure 6–13   Multiple Visual Elements

EXERCISE: SHOW KIDNAPPINGS ON A TIMETABLE

1. Show Kidnappings on a New Timetable

2. Display the following columns:

• Event Date

• Event location
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• Guerrilla units

• Number kidnapped

• Ransom

• Responsible group

• Roadblock

• Victim type

3. Configure timeline with the following:

• Add Date Bar with Icon

• No display range

• Discrete Event date

• No label

4. Add the following Quick Filters:

• Victim Type

• Roadblock

• Ransom

• Responsible Group

5. Save your display properties as Kidnappings Timetable

6.3 Link Analysis

 Link Analysis tells you more about your query results. Specifically, you can see 
the relationships that exist between objects—relationships that may not be readily 
visible in the traditional query result views. 
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Figure 6–14 reveals linkages between an employer (Blackboard) and residents of a 
town (Harbin). If you were trying to find a link between Lou Johnson and Kevin 
Graves, you could see that Kim Aspen works with Kevin Graves and lives near 
Lou Johnson. Kim Aspen may be a key person to contact. 

Figure 6–14  Link Analysis

Object Nodes—The object nodes in a Link Analysis diagram include things like 
people, companies, organizations, locations, equipment, and so on. The types of 
object nodes are limited only by what is stored in the database you are looking at. 

Relationship Links—The relationship links in a Link Analysis diagram appear as 
lines between the objects. Relationships include whatever has been defined in the 
database or can be derived from it, for example: 

• Components of a system 

• Organization memberships 

• Cities or addresses 

• Callers and receivers 

• Airbase assignments 

• Time and distance relationships 
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Like object nodes, relationships are limited only by what is stored in the database. 
A relationship can be expressly defined with the Modify Relationships option or 
derived from the data using Derived Relationships. WebTAS also uses existing 
relationship data from external sources that support it, such as CTAVRS or MIDB. 

6.3.1 Running Link Analysis

To launch the Link Analysis tool, highlight an object in a view, right-click, and 
choose Link Analysis. You can also click the toolbar button or choose Edit > Link 
Analysis from the pull-down menus. 

Figure 6–15  Target and Layout Properties

Link Analysis—Use the Link Analysis tab (see Figure 6–15) to name the display 
and set the number of layers to display "out" from the source object.

Node Properties—Use the Node Properties tab (see Figure 6–16) to assign icons 
and format labels for the objects listed in the tree on the left. 

Icons can be fixed or data driven. When you send the results to a map, you can 
have the icon change size as you zoom in and out. Letting WebTAS icons resize 
themselves helps prevent icon crowding as you zoom out. 
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Figure 6–16  Node Properties

Link Properties—Use the Link Properties tab (see Figure 6–17) to format the 
relationship lines (grouped in the tree on the left) between objects. The lines and 
label text can be fixed or data driven. 

Figure 6–17  Link Properties
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6.3.2 Changing the Default Layout 

Use the Link Analysis pull-down menu (see Figures 6–18 and 6–19) to change the 
overall layout. The Radial Tree Layout option is the default. 

Figure 6–18  Link analysis Pull Down
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Figure 6–19  Link Analysis Layouts
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6.4 Using Graphs

WebTAS can create a variety of graphs for visually grouping any combination of 
data. For example, a graph can help assess the types of events that have taken place 
over a given timeframe. 

6.4.1 Types of Graphs

WebTAS provides the following types of graphs:

•  Bar Graph 

•  Stacking Bar Graph 

•  Line Graph 

•  Scatter Plot 

• Area Graph 

•  Stacking Area Graph 

•  Pie Chart 

6.4.2 Formatting a Graph

The Graph Display Properties dialog (see Figure 6–20) lets you choose attributes 
for display and lets you format the graph appearance.
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Figure 6–20  Graph Properties

6.4.2.1 Bar Graph

A bar graph displays data in a two dimensional X–Y format, usually with the 
dependent variable for the X location and the independent variable for the Y 
location. Figure 6–21 shows a sample bar graph. 
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Figure 6–21  Bar Graph

6.4.2.2 Stacking Bar Graph

Stacking bar graphs display data in a bar graph format but with color-coded results 
stacked on top of each other as shown in Figure 6–22.

Figure 6–22  Stacking Bar Graph
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EXERCISE: SHOW KIDNAPPINGS ON A STACKING BAR GRAPH

1. Show Kidnappings on a Graph

2. Accumulate by Number Kidnapped

3. X Axis: Event Date/ Day of Week

4. Secondary Attribute: Victim Type

5. Graph style Stacking Bar

6. Save your display properties as Kidnapping SB graph

6.4.2.3 Line Graph 

Line graphs display data as points connected by straight lines. Line graphs can be 
helpful in discerning trends in date-related information. Figure 6–23 shows a 
sample line graph.

Figure 6–23  Line Graph
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6.4.2.4  Scatter Plot 

Scatter plots display data as points in X–Y format as shown in Figure 6–24.

Figure 6–24  Scatter Plot

6.4.2.5 Area Graph 

Area graphs show data as overlapping line graphs, where the area beneath each 
line is filled. Figure 6–25 shows a sample area graph
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Figure 6–25  Area Graph

6.4.2.6  Stacking Area Graph 

Stacking area graphs look like area graphs except the areas are stacked on top of 
each other as shown in Figure 6–26.

Figure 6–26  Stacking Area Graph
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6.4.2.7  Pie Chart 

Pie charts display data as slices of a circle, as shown in Figure 6–27. Pie charts are 
helpful for visualizing relative quantities and percentages.

Figure 6–27  Pie Chart

EXERCISE: SHOW KIDNAPPINGS ON A PIE CHART

1. Show Kidnappings on a New Graph

2. Accumulate by Number Kidnapped

3. X Axis: Class

4. Secondary Attribute: Event Date/ Day of Week

5. Set Graph style to Pie

6. Save your display properties as Kidnapping Pie Graph
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6.5 Using Charts

WebTAS can create a variety of charts for visually grouping any combination of 
data. For example, a chart can help assess the types of events that have taken place 
over a given timeframe. 

6.5.1 Types of Charts

WebTAS provides the following types of charts:

• Pie

• Bar

• Stacked Bar

• Stacked Bar 3D

• Line

• Line 3D

• Area

• Stacked Area

• Layered Bar

• Scatter

• Block

• Step

6.5.2 Formatting a Chart

When sending a query to a chart the Chart will open in the Edit Mode.
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Figure 6–28  Edit Mode

Select one of the three tabs:

• Category

• Pie

• XY

Then populate the X and Y axis or the Pie chart slice data and select the display as 
type.
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Figure 6–29  Category and XY Display as Types

EXERCISE: SHOW KIDNAPPINGS ON A PIE CHART

1. Query Show Kidnappings on a Chart.

2. Select the Pie tab.

3. Use Victim Type as the Pie Slice and Number Kidnapped as the Pie slice 
Size.

4. Add Kidnappings by Victim Type as the title.

5. Show the Legend.

EXERCISE: SHOW KIDNAPPINGS ON A CATEGORY CHART

1. Query Show Kidnappings on a Chart

2. Select the category tab.
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3. Use Victim Type as the X-Axis and Number Kidnapped as the Y-Axis

4. View all of the possible display types.

5. Add Victim Type as a Sub-type

6. View all possible display types.

EXERCISE: SHOW KIDNAPPINGS ON AN XY CHART.

1. Query Show Kidnappings on a Chart

2. Select the XY tab.

3. Use Victim Type as the X-Axis and Number Kidnapped as the Y-Axis

4. View all of the possible display types.

5. Add Victim Type as a Sub-type

6. View all possible display types.

6.6 Using Grids

WebTAS can chart data on a grid, which is a matrix designed to display correlated 
clusters of events or objects as shown in Figure. The example shows three 
dimensions: a horizontal weekday, a vertical month, and each cell with 
accumulated counts.
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Figure 6–30  Grid

6.6.1 Formatting a Grid

The Grid Display Properties dialog lets you choose attributes for display and lets 
you format the grid appearance. WebTAS displays the Grid Display Properties 
dialog when first creating a grid see Figure 6–31. 

Figure 6–31  Grid Display Properties

Once displayed, grid axes show rank and count values as seen in Figure 6–32. (A 
rank that includes a "T" is tied with another row or column.) 
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Figure 6–32  Grid Rank and Count Values

You can prevent a grid row or column from changing position when you re-sort the 
associated axis by clicking the header button for the row or column. A padlock 
symbol appears as shown in Figure 6–32. You can click a header button again to 
unlock the row or column.

Exercise: Show Kidnappings on a Grid

1. Show Kidnappings on a New Grid

2. Set By Attribute Number Kidnapped

3. Horizontal Axis: Event Date/2 hour intervals

4. Vertical Axis: Event Date/Day of Week

5. Save your display properties as Kidnappings Grid

6.6.2 Operations Clock

The circular option for a grid (see Figure 6–34) lets you create a 24-hour 
operations or "ops" clock that shows time-of-day information at a glance. 

Exercise: Create an Ops Clock

1. Create a valid query and send it to a New Grid.

2. Check the Make Circular checkbox (see Figure 6–33). 

3. For the horizontal axis, choose a date attribute and "Hour of Day" as shown in 
Figure 6–33. 
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Figure 6–33  Grid Properties - Ops Clock

4. Choose an attribute for the vertical axes. 

5. Click the OK button. 

The ops clock populates its display with results that are positioned at the time of 
day that they occur (see Figure 6–34). Note that the ops clock is in 24-hour 
format—the example data in Figure 6–34 occurs from afternoon through night into 
the early morning hours.
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Figure 6–34  Ops Clock

6.7 Using Google Earth

If your administrator configured WebTAS with Google Earth as explained in the 
WebTAS Installation and System Administration Manual, the following additional 
option appears as a view output choice on the Query Panel. 

Send Results to Google Earth 

Sending your results to Google Earth launches the Google Earth application and 
overlays the result objects onto the overhead photographic satellite view as shown 
in Figure 6–35. 
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Figure 6–35  Google Earth Example

Google Earth is a separate application that must already be installed on the system 
before this option will work. You can save these "WebTAS" views in Google 
Earth and return to them by opening them later—directly in Google Earth and 
independent of whether Project Tool is running or not. 

Google Earth provides its own interface for viewing, zooming, saving, or 
otherwise working with its imagery. See the Google Earth documentation for 
specifics about working with Google Earth, either on its own or as an application 
that WebTAS launches. 

6.7.1 Configure Google Earth

You can configure WebTAS to use Google Earth by modifying the 
webtas.client.properties.3.1.0.0 file as follows:

############################################################
######
# Keyhole Export Configuration (aka Google Earth properties)
#
# To enable Google Earth maps:
#   1. Install Google Earth
#   2. Uncomment the 3 keyhole property lines below
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#   3. Verify that the path specified for keyholeApplication 
is correct for your system
#   4. Verify that the path specified for keyholeTempDir is 
correct for your system
############################################################
#######
#keyholeEnabled=true
#keyholeApplication=C:/Program Files/Google/Google 
Earth/GoogleEarth.exe
#keyholeTempDir=C:/WebTAS

Uncomment the three lines in Red above. Ensure the Paths to the Google Earth 
executable and the Temp directory are correct.
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Overview 

Security Manager is the application used to manage discretionary access control 
(DAC). Using the Security Manager you can create roles and users, specify what 
capabilities are associated with each role and which users are assigned to the 
various roles. Security Manager also allows for the importing and exporting of 
roles, users and security settings from spreadsheet files. After you have updated 
the global data dictionary, using the Domain Editor, you can set up security for the 
domain using the Security Manager. 

Module Objectives

After completing this module, you will be able to:

Create Roles

Create Users

Explain LDAP Import Process

Import and Export Settings to Spreadsheets
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7.1 Overview 

Security Manager has two panes. The left pane contains three tabs—Roles, Users, and 
Admin—where you access the subtabs to create, edit, and delete roles and users; and, manage 
other administration tasks. 

The right pane contains multiple subtabs to work with roles, users, security, time-out, 
password policies, LDAP configuration, and import/export configurations. 

Figure 7–1  Security Manager

7.2 Create Roles
WebTAS roles control user access to domain data and control the program actions users can 
perform with the data. When creating roles, you should consider how users will work with the 
WebTAS domain and how you want to restrict access to data and functions. You can create 
as many roles as you want, but you must create at least one role. A user may be assigned to 
one or more roles, but must be assigned to at least one. 
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7.2.1 Set the Access Privileges for the Role

After you add a role, configure the appropriate permissions to access class and subclasses in 
the domain. To initially configure or to modify the access permissions, select the Role tab and 
the Access subtab. 

Figure 7–2  Access Tab

The Access subtab contains a tree of classes and subclasses. If a class has subclasses below it, 
you will see an Expand Tree (+) button. Use the Expand Tree (+) and Collapse Tree (-) 
buttons to work with classes and subclasses. 

In the Access subtab, customize the permissions you want to grant to the role for access to 
each class or subclass. 

You can select one or more of the following permission types for a selected class or subclass: 

• Create [C]—Allows this role to add data for the specified class to the WebTAS 
native database. 

• Read [R]—Allows this role to run queries on the specified class data. 

• Update [U]—Allows this role to update existing data for the specified class in the 
WebTAS native database. 

• Delete [D]—Allows this role to delete data for the specified class from the WebTAS 
native database. 

• All [CRUD]—Allows this role to perform all create, read, update, and delete 
functions. 

• None—Denies all access to the class. 
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Apply to Branch—Applies the same permission types as the class to all of its subclasses. 

Note
For a new role, the default permission type for each class is None

For the Create, Read, Update, or Delete permission types, when you grant the permission to a 
role, an indicator consisting of the first letter of the permission type (C, R, U, or D) appears to 
the right of the class name in square brackets. Multiple permissions result in multiple 
indicators to the right of the class name. If All is the permission type, [CRUD] appears to the 
right of the class name. If a role has a Create, Update, Delete, or All permission type, the 
class name appears in boldface type. If the permission type selected for a role is None or 
Read (only), the class name appears in regular type. 

For some roles, you may need to configure the permission to a finer degree of granularity. For 
example, suppose you gave Role1 read access to the Clashes class, but you want to limit the 
clashes that Role1 can read to those occurring after August 1. In this scenario, you can limit 
the read permission by editing the data-driven constraint. The Edit Data Driven Constraints 
button opens a dialog box allowing you to define query constraints for each of the Create, 
Read, Update, and Delete permissions. See the WebTAS User Guide for information about 
editing queries. 

If you want all subclasses of a particular class to have the same permission types as the class, 
you can select the Apply to Branch button. Then edit the subclass permissions, if necessary. 
However, the permissions defined for a subclass cannot be less restrictive than the 
permissions defined for the class. For example, if the role has Read and Update permissions 
to the TAS Objects class and also Create or Delete permissions for the Alerts subclass, Alerts 
will still have only Read and Update permission because it cannot have more privileges than 
its parent class. 

7.2.2 Set Action Privileges

After you add a role, you need to determine the program actions you want users with this role 
to be able to perform. Users may invoke a program action by interacting with the user 
interface (for example, by selecting a toolbar menu item or clicking a button). To set up 
access, you use the Actions subtab on the Role tab in the Security Manager window. 

Similar to the Access subtab, the Actions subtab contains a tree of actions. If a folder has 
actions below it, you will see an expand tree (+) button or a collapse tree (-) button to the left 
of the folder icon. 

There are two options for permissions to actions: 

• Allow—Grants permission for the action to the role. 

• Deny—Does not permit the role to perform the action. 
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The two additional options include: 

• Apply to Branch—With a class with subclasses selected, click to apply the action 
permission for the class to the subclasses. 

• Hide denied menu items—When selected, it removes all actions that are denied for 
the role (not just the ones you select) from the WebTAS application menu. 

Note
For the program actions you permit, you must ensure the role has 
access to the appropriate classes and subclasses on the Access subtab. 
Otherwise, program actions will not display correct and complete data. 

Figure 7–3   Actions Tab 

 You can either Allow or Deny access to an action. The default setting is Deny.

7.2.3 Assign Users

The Assigned Users subtab on the Roles tab allows you to assign one or more user accounts 
to one selected role.
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Figure 7–4  Assigned Users

7.3 Adding Users
Eventually you must create at least one user and role with full access in order to perform 
additional administrative activities for WebTAS. For example, you cannot log back on to 
Domain Editor (nor can you log on to Project Tool) without an account and role from 
Security Manager. 

7.3.1 Existing User Accounts

Several system-generated proxy accounts are created during the WebTAS install. 

XML Exporter and Importer and the Import Tool 

• K-PASA/RT 

• Admin 

• Guest 

• wuser 

• esb 

Since account authorization is granted and not obtained by default, these accounts are created 
for you to use as templates. Access privileges for these accounts is set to all actions denied 
and all data access permissions set to None. 
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7.3.2 Account Tab

When you are creating a new user or updating information about an existing user the account 
tab is the starting point.

Figure 7–5  Account Tab

The following options/entries exist on the Account tab:

• User Password—Password requirements for user accounts (not downloaded via 
LDAP) are configured on the Admin/User Accounts tab.

• Account Locked—If you want to lock the account so the user cannot log on, select 
the Account Locked check box; otherwise, leave the check box cleared

• Force Password—If you want to force the user to change the password at first log 
on, select the Force Password check box.

• Authentication Source—An authentication source is always dependent on how the 
user account is created. The authentication source tells WebTAS how user 
information will be managed either by Lightweight Directory Access Protocol 
(LDAP) or Security Manager User Accounts. 

• Utility Class Name—Some services and utility programs need to run in situations in 
which they cannot be authenticated interactively.
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Users must be assigned a role. If you attempt to save the user information at this point an 
error dialog will appear and you will be forced to select a role for the user.

7.4 Admin Tab
On the Admin tab, you can select and configure the authentication source, set security policy 
enforcement options, set the administrator's password, and establish a system time out (see 
Figure 7–6.) You can also choose the type of password control you want to use and look up or 
download user information using Lightweight Directory Access Protocol (LDAP) server. 

Figure 7–6  Admin - General Tab

7.4.1 General Tab

7.4.1.1 Set Security Policy

The security policy enforcement settings determine how overall WebTAS security is 
enforced. 

• Users must login—Enforces users to log on every time they open WebTAS. 

o When someone tries to log on to WebTAS without an existing user account, 
they are automatically assigned the Guest user with read-only rights. 
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o When User must login and Permissive Password (on the Accounts subtab) are 
selected, the settings for the password can be anything including just one 
character. 

o When User must login and Strict Password with no limits to the password 
format (on the Accounts subtab) are selected, the settings for the password can 
be anything including just one character. 

• Data access controlled—Enforces the settings for access to classes and subclasses 
established on the Roles tab/Access subtab. 

• Program actions controlled—Enforces the settings for program actions established 
on the Roles tab/Actions subtab. 

Important
If you established role-based settings for access to data and for 
program actions, those settings are only enforced when you select the 
corresponding check boxes on the Admin tab/General subtab. 

7.4.1.2 Set Administrator Password

The Administrator Password you entered when you logged in to Security Manager is the 
default administrator password (displayed as asterisks). You can change the administrator 
password in the Administrator Password group box 

7.4.1.3 Set Inactivity Timeout

You can choose whether to log users out of WebTAS after a specified period of inactivity. 

7.4.1.4 Allowing Multiple Administrators 

You can indicate whether you want to designate certain users as domain administrators or 
user administrators. A user identified as a domain administrator has FULL _ACCESS to 
Security Manager functions for the selected domain. Only a domain administrator or the 
WEBTAS_ADMIN account has the ability to designate a user as a domain administrator or a 
user administrator. 

A user administrator has responsibility for managing user accounts for their organization or 
group. A user administrator may create, update, and delete user accounts assigned to specific 
roles. However, a user administrator only has permission to work with certain roles and can 
only assign or remove those specific roles when creating or updating user accounts. Updating 
capabilities also include resetting passwords, unlocking user accounts, forcing password 
changes, and updating user contact information. 

The user administrator cannot perform domain functions such as creating and administering 
roles, choosing password policies, or importing users from LDAP. 
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If you select the Allow Multiple Admins check box on the General subtab, Security Manager 
creates additional tables in the database and two additional subtabs—Domain Admin and 
User Admin—appear on the Admin tab (Figure 7–7). The additional subtabs allow you to 
identify multiple domain administrators and user administrators. 

Figure 7–7  Multiple Admins

7.4.2 Accounts Tab

The Accounts tab is used to manage user accounts.

7.4.2.1 Setting User Names Policy

• Names are case sensitive—requires users to provide a login name with the same 
case used when the user's account was created. For example, John Doe will not be 
able to login as john doe. This policy will be enforced regardless of whether LDAP 
or Security Manager accounts are used for authentication. 

• Get login name from Operating System—disables the username field in the user 
login dialog box. That field will be populated with a username retrieved from the 
operating system. This effectively prevents users from logging into the system from 
another user's workstation. This policy will be enforced regardless of whether LDAP 
or Security Manager accounts are used for authentication. 

7.4.2.2 Enabling Guest User Policy 

Guest accounts are a way to accommodate sites whose users are not always known ahead of 
time. Guest accounts can only be enabled when users are not required to logon, and a 
mandatory part of enabling the feature is selecting the guest user account. The admin creates 
that account with roles that have permissions appropriate for guests. 

7.4.2.3 Set up Password Policy Settings 

Select the checkbox(s) that you want to enforce.

• Must be of mixed case—Must have lower and upper case letters.

• Must contain numerals—Must contain at least one numeric character (0-9).

• Must contain special character—Must contain at least one special character.
The underscore (_) character does not count as a special character.

• Minimum length—You can specify the minimum length from 8 to 40 characters.
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7.4.2.4 Setting Password Controls 

The password controls allow you to specify how long a password is valid and the number of 
new passwords you must create before reuse of old passwords is allowed.

7.4.3 LDAP Configuration Tab

WebTAS uses Lightweight Directory Access Protocol (LDAP) to communicate with external 
user directories. If you will not be using LDAP for either authentication or for user import, 
you can skip this section. 

Warning
If you are going to use LDAP read the Security Manager guide to 
ensure proper precautions are taken. This course material is not 
adequate to perform safe LDAP downloads.

Figure 7–8  LDAP Configuration Tab

7.4.3.1 Manage User Downloads 

The User Download section (see Figure 7–8) allows you to perform the following tasks:
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• Remove LDAP users first—remove the list of LDAP users so that the new 
download will re initialize it. 

• Remove ALL users first—remove the list of all users so that the new download 
will re initialize it. 

• Add only new users—download only new users, keeping the prior user list 
unchanged. 

• Assign LDAP Groups as Roles—map users in Windows domain groups to 
matching Security Manager roles, if a match exists. 

• Test the Connection—execute a test of the connection to the LDAP download 
source. 

• Download Users—perform the download. 

7.4.3.2 Setting Connection Values 

Use the three LDAP Configuration subtabs to set the values for the LDAP download. 

7.4.3.2.1 Connection

For a detailed explanation of each field see the Security Manager Guide. Ensure this 
section is completed before attempting to test the connection.

7.4.3.2.2 Configure the User Attribute Settings 

User attributes tell the system which user contact information from an external directory 
you want to use in WebTAS. You can use the preestablished attributes, or you can 
customize the information by adding rows for new information, or removing rows. 

7.4.3.2.3 Configuring Data Dictionary Attribute Settings 

To map the LDAP attributes to attributes of a class defined in the Data dictionary, 
specify the mappings in the DD Attributes table. 

7.4.4 Import/Export Settings Tab

If you have user accounts, roles, and security settings in Excel, you can import that 
information using the Import/Export Settings tab. You can also back up your current settings 
by exporting them to a spreadsheet. This feature is intended to facilitate initialization of a 
system with settings exported from some previously configured system that uses the same 
domain.



 
7 Using Security Manager 
WebTAS Training v3.3.2 • 17 February 2009 

7–14 
 

The best way to create the required spreadsheets is to perform an Export, which creates the 
spreadsheets in the required format. You can then make changes to the spreadsheet and 
perform the Import. This is also a convenient way to reset the system configuration to a 
known state.

A good practice is to perform an export soon after installing WebTAS and configuring roles, 
users, and settings. That way, you have a known initial state that you can restore. 

Note
You must choose a directory before you can import or export 
spreadsheets.

Exporting produces the following files: 

• RoleData.xls—containing role information 

• UserData.xls—containing user information 

• ConfigData.xls—containing security settings 

7.4.4.1 Importing Roles, Users, and Security Settings from Spreadsheets 

You can import roles, users, and security settings from spreadsheets by selecting the directory 
and then clicking the Import button. 

Note
It it not required that all spreadsheets (RoleData.xls, UserData.xls, and 
ConfigData.xls) exist in the specified directory for importing. If, for 
example, you are importing to update the user set you may wish to 
have only the UserData file in the directory. Limiting the number of 
imported files will make the import operation faster. 

When importing the spreadsheets you must select e of the following options:

• (Re)Initialize the system—Deletes existing information and replaces it with the 
imported information.

• Add new or modified records—Compares the spreadsheet records and existing 
records. New records are added. If there are existing records that differ from the 
imported records (a role's permissions have changed, etc.) then the existing record is 
replaced. This mode may take more time depending on how many records must be 
compared.

• Add only new records—Adds only new records. Does not change existing records.
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8 Domain Editor Tour 
Module Time: 30 minutes
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Overview 

Your aim is to create a domain, based on the available data sources, that is easily 
comprehensible to the analysts/operators using WebTAS. A domain describes the 
data model that WebTAS will use to manipulate data. As a review this data model 
is hierarchical and contains information describing the following:

• Data Sources—contain Classes

• Classes—contain Attributes

• Attributes—correspond to abstract data types

• Picklists—lists of values that can be associated with attributes

• Unit Categories and Units—categories (such as "Distance") containing any 
number of different units of measure (such as "Feet" and "Meters"), plus 
factors for converting between each

• Joins and Relationships—define linkages between classes.

A domain is stored as a file using eXtensible Markup Language (XML). (Most) 
WebTAS applications read a user-selected domain file at initialization time and 
configure themselves to operate within the given domain model.

The original data in the external data sources are not altered by WebTAS; only 
their representations in WebTAS and/or the native database are customized. In this 
way, WebTAS preserves the integrity of data being analyzed. 

 Module Objectives

After completing this module, you will be able to:

Describe the components that comprise the basic domain structure
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Understand the classes in a TAS Object

Understand what items appear in the left and right panes of the Domain 
Editor

8.1 Opening Domain Editor

To open Domain Editor, do the following: 

1. Select Start > Programs > WebTAS  Client > Administrator Tools > 
Domain Editor. (or right-click the data dictionary and select Open with 
Domain Editor)
The Choose a Domain window appears (Figure 8–1). 

Figure 8–1  Choose Domain

2. Select the appropriate domain or click the Choose File button to browse to the 
domain. This window does not appear if you use the right-click method.

3.    Click OK.
The Domain Editor window appears (Figure 8–2). 
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Figure 8–2  Domain Editor

8.2 Domain Editor Window 

The left pane or Domain pane of the Domain Editor window lists the structural 
hierarchy of the current domain. This hierarchy includes all classes and subclasses, 
as well as picklists, tables, and units supporting data contained in the classes. 

The right pane of the Domain Editor window displays one of a series of tabbed 
windows listing either class data or Domain Editor information, depending on the 
tab selected.

8.2.1 Domain Panel

All WebTAS domains are built using the same basic structure and components. 
Though this structure is expanded and enhanced for complex domains, the basic 
elements remain the same. 

The following components comprise the basic domain structure. 

• Default Location Data Entry Style—Specifies the format for the location 
style.
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Figure 8–3  Location Style

• Preferred Center Point—Default lon/lat set to 000000.000N 0000000.000E. 
To edit the Preferred Center Point location, double-click Preferred Center 
Point. 

• Business Layer Properties—Defines the data source and renderers location, 
actions, delegates, and KPASA actions, if any. 

• Data Sources—Lists all data sources to which the system currently connects. 
Expand the Data Sources folder and the WebTAS Default Data Source is 
visible. The Default Data Source represents the WebTAS native database 
required for standard WebTAS installations. This database contains a skeletal 
domain structure and security information. Other external data sources to 
which the system connects are also listed, if any. 

• Derived Relationships—Lists all additional relationships that are not 
explicitly defined using Joins, Table Joins, and Relationships.

• Picklists—Define the lists of valid attributes from which users can select 
when querying the domain using the Project Tool. This enables users to quickly 
see all available attribute options and prevents entry of invalid options. 

• Queryable Objects—Lists all of the queryable object classes configured 
within the domain. 

• Units—Lists the units of measure available for use within the domain. By 
default, units are organized into categories that have one or more specific units 
of measure. For instance, the Distance category contains the following specific 
units: Kilometers, Meters, Nautical Miles, and Stature Miles. When you select 
Distance, these units appear in the right pane of the Domain Editor window. 
The reference unit for distance is Nautical Miles (conversion factor of 1), and 
all other units are calculated in relation to this unit. 

The components described above are expanded and enhanced when you map data 
structures from external data sources into a domain.
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Figure 8–4  Domain Editor

8.2.1.1 TAS Object

In every WebTAS domain the base class is named TAS Object. It is called the base 
class because it appears at the top of the class hierarchy tree and is common to all 
WebTAS domains. It often contains the following subclasses: 

• Alert 

• Assessment 

• Assessment History 

• Event

• Organization

• Person

• Place 

• Prediction 

• Relationship 

• Tasking Object
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You can add other classes and subclasses to the base class as desired. 

8.3  Right Pane 

The right pane contains four subtabs. Click the tab to display the corresponding 
page.

• Data Tab

• Tabular Tab

• Log Tab

• GUI Tab

8.3.1  Data Tab 

The Data tab appears by default when you start the Domain Editor. Highlight a 
class in the left pane to display the data (attributes and tables) and subclasses of the 
class. You can select classes, class attributes, picklists, tables, and units displaying 
on this page for editing purposes. 
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Figure 8–5  Data Tab View

8.3.2 Tabular Tab

The Tabular tab displays non-editable information summarizing the properties of 
attributes contained in the highlighted class. This information provides helpful data 
about attributes, including names, data types, lengths, descriptions, whether the 
attribute value is required upon creation of an object and so on. 

Data for all the attributes displays and includes the attribute name, data type, field 
length, and a description of the attribute. Also displayed on this page are fields 
which are defined when creating or modifying an attribute.
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Figure 8–6  Tabular Tab View

8.3.3 Log Tab

Click the Log tab to display a running log of WebTAS execution messages. These 
messages may be somewhat cryptic yet are useful to the WebTAS Development 
Team in case errors occur during the execution of Domain Editor. In the future, 
more comprehensive messages detailing all additions, modifications, and deletions 
of classes, tables, or attributes will display on this page.



 
8 Domain Editor Tour 
WebTAS Training v3.3.2 • 17 February 2009 

8–10 
 

Figure 8–7  Log Tab View

8.3.4 GUI Tab

The GUI tab displays the GUI layout hierarchy shown to the user when entering a 
class instance. The position of the GUI relative to other attributes' GUIs within a 
window can also be specified

You can reorder class attributes using the reordering (up/down) buttons shown in   

Use the Test Edit Template option to check the appearance and behavior of the 
data entry window as it will appear to users. 
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Figure 8–8  GUI Tab View

8.3.5 Toolbar

Both the menu bar and the toolbar contain many of the options you will use when 
working in Domain Editor. Also, some options appear on right-click menus

Figure 8–9  Domain Editor Toolbar

For a description of the icons see the Domain Editor Manual. All actions are also 
available from the Edit > New > Choices.
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9 Using the Domain Editor 
Module Time: 2.5 hours
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Overview 

Field Engineers are often tasked with creating new domains which connect a 
variety of data sources in ways that are useful to a given customer. This process 
requires mapping in various tables, creating classes, tables, and attributes, defining 
joins, and creating native relationship classes. Very often a snippet or a mask may 
be used when creating an attribute to combine, manipulate, or otherwise format the 
database data before using it in WebTAS displays.

Module Objectives

After completing this module, you will be able to:

Create an Empty Domain

Create a New Table and Class (Native)

Create New Attributes (Native)

Create Picklists and associate with attributes

Map an External Data Source to the domain

Create Location Attributes

Define Joins

Configure Queryable Objects Folder
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9.1 Create an Empty Domain 

There are two methods to create an empty domain:

The easiest is to select New Domain from the Choose a Domain dialog. Then 
answer the questions to create an empty domain. (Not currently functional)

Figure 9–1  Choose a Domain

In the second method there are four steps required to create a new domain:

1. Create the database to be used as the WebTAS Default Data Source.

2. Create a Data Dictionary.

3. Run the Security Manager to create Roles and Users.

4. Run the Domain Editor to create additional tables in the database.

9.1.1 Create the Database

For all databases except Microsoft Access, create a separate database schema and 
user.

Create a new native database in the product of choice. Create a user login to that 
database that will be shared across all WebTAS users.
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This configuration is possible because WebTAS Security Manager controls access 
to the database, relying less on the database product itself.

Note
The particulars for each database are beyond the scope of 
this document. Refer to the database product 
documentation for instructions regarding installation, 
configuration, and management of the database and its 
users. Involve the database administrator if necessary.

For Microsoft Access

Create a dierctory named databases in C:\WebTAS-UserSpace. Launch Microsoft 
Access and create a new database. For example, myaccessdb.mdb. Save the 
database to the WebTAS databases directory (C:\WebTAS-UserSpace\databases 
by default).

9.1.2 Create a Data Dictionary

Make a copy of the client.wtdd file(located in C:\Program Files\WebTAS\Domain 
Templates), paste in the C;\WebTAS-UserSpace\domains directory, and rename 
the copy to something meaningful (your-domain.wtdd).

Open your-domain.wtdd in a text editor.

Find the <Name> element near the top of the file:

<Name>WebTAS Data Dictionary</Name>

Rename the domain to something meaningful to you. Choose a name that is similar 
to the base filename ("your-domain") for your *.wtdd file.

<Name>Your Data Dictionary</Name>

Find the <DataSourceConnInfo> element:

<DataSourceConnInfo>
<Name>WebTAS Default Data Source</Name>
</DataSourceConnInfo>

Expand or replace the <DataSourceConnInfo> element with the connection 
settings for your database product. Paste the appropriate boilerplate settings into 
yourdomain.wtdd (right after <Name>WebTAS Default Data Source</Name>).

Then, update the entries with your specifics.
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Templates--Connection Settings for Supported, Non-
Microsoft Access Databases

Oracle

<SourceURL>jdbc:oracle:thin:@<database host name or ipaddress>:<port 
number>:<instance name></SourceURL>
<DataSourceDriver>oracle.jdbc.driver.OracleDriver</DataSourceDriver>
<UserId>db_account_login_id</UserId>
<Password>account_password</Password>
<Schema>database schema name</Schema>

Example:

<SourceURL>jdbc:oracle:thin:@oraclesvr:1521:ORCL</SourceURL>
<DataSourceDriver>oracle.jdbc.driver.OracleDriver</DataSourceDriver>
<UserId>myuser</UserId>
<Password>password</Password>

<Schema>myuser</Schema>

Microsoft SQL Server

<SourceURL>jdbc:jtds:sqlserver:<database host name or ip address>:<port 
number>/<database name></SourceURL>
<DataSourceDriver>net.sourceforge.jtds.jdbc.Driver</DataSourceDriver>
<UserId>db_account_login_id</UserId>

<Password>account_password</Password>

Example:

<SourceURL>jdbc:jtds:sqlserver:123.45.67.89:1234/mydb</SourceURL>
<DataSourceDriver>net.sourceforge.jtds.jdbc.Driver</DataSourceDriver>
<UserId>mydbuser</UserId>
<Password>password</Password>

Sybase

<SourceURL>jdbc:sybase:Tds:<database host name or ip address>:<port 
number>/<database name></SourceURL>
<DataSourceDriver>com.sybase.jdbc2.jdbc.SybDriver</DataSourceDriver>
<UserId>db_account_login_id</UserId>
<Password>account_password</Password>

Example:

<SourceURL>jdbc:sybase:Tds:143.56.78.21:2220/MySybaseDB</SourceURL>
<DataSourceDriver>com.sybase.jdbc2.jdbc.SybDriver</DataSourceDriver>
<UserId>mysybaseuser</UserId>
<Password>password</Password>

PostgreSQL

<SourceURL>jdbc:postgresql:<database host name or ip address>:<port 
number>/<database name></SourceURL>
<DataSourceDriver>org.postgresql.Driver</DataSourceDriver>
<UserId>db_account_login_id</UserId>
<Password>account_password</Password>

Example:
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<SourceURL>jdbc:postgresql:dbsvr:2345/mydb</SourceURL>
<DataSourceDriver>org.postgresql.Driver</DataSourceDriver>
<UserId>myuser</UserId>
<Password>password</Password>

MySQL

<SourceURL>jdbc:mysql:<database host name or ip address>:<port 
number>/<database name></SourceURL>
<DataSourceDriver>com.mysql.jdbc.Driver</DataSourceDriver>
<UserId>db_account_login_id</UserId>
<Password>account_password</Password>

Example:

<SourceURL>jdbc:mysql:123.45.67.89:2110/mysqldb</SourceURL>
<DataSourceDriver>com.mysql.jdbc.Driver</DataSourceDriver>
<UserId>myuser</UserId>
<Password>password</Password>

Hypersonic SQL (HSQL)

<SourceURL>jdbc:hsqldb:hsql:<database host name or ip address>:<port 
number>/<database name></SourceURL>
<DataSourceDriver>org.hsqldb.jdbcDriver</DataSourceDriver>
<UserId>sa</UserId>

Example:

<SourceURL>jdbc:hsqldb:hsql:hsqldbsvr:2345/mydb</SourceURL>
<DataSourceDriver>org.hsqldb.jdbcDriver</DataSourceDriver>
<UserId>sa</UserId>

Note
The default user id for HSQL is "sa" unless specifically 
set by the administrator.

Connection Settings for Microsoft Access Databases

Replace the <DataSourceConnInfo> element as follows:

<DataSourceConnInfo>
         <Name>WebTAS Default Data Source</Name>             
<SourceURL>jdbc:odbc:DRIVER={Microsoft Access Driver 
(*.mdb)};DBQ=C:\WebTAS-UserSpace\databases\myaccessdb.mdb</SourceURL>
      <DataSourceDriver>sun.jdbc.odbc.JdbcOdbcDriver</DataSourceDriver>
</DataSourceConnInfo>

Change the filename myaccessdb.mdb to the name of your database.
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9.1.3 Run Security Manager to Create Roles and 
Users

Security Manager automatically adds and updates the administration tables 
required to support WebTAS.

Run Security Manager 

1. Select Start > All Programs > WebTAS  Client> Administrator Tools > 
Security Manager.
The Choose a Domain window appears.

2. Open the domain.wtdd or use Browse Domains to find the domain.

3. Security Manager will inform you data migration must occur before using 
this database. This happens when creating a new domain or migrating an 
older, existing domain.

Figure 9–2  Database Upgrade

4. Click OK.

5. Security Manager automatically adds and updates the administration tables 
required to support WebTAS.

6. When prompted, set the WebTAS administrator password.

7. Click OK.

8. Add roles and users for your environment.

Note
You must create at least one role and one user. The role 
should have all privileges.

9. Click Save.
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9.1.4 Run Domain Editor to Create Additional Tables 
in the Database

The Domain Editor will create all of the additional table required to make your 
domain functional.

Run Domain Editor

1. Select Start > Programs > WebTAS Client > Administrator Tools > 
Domain Editor.
The Choose a Domain window appears.

2. Select the domain.wtdd or click Browse Domains to find.

3. Select Database > (Re)Create All Database Tables.
Domain Editor displays a warning that this action will cause all database 
tables to be (re)created.

4. Click Yes.
All remaining WebTAS tables needed for the native database are created.

5. Click the Log tab to check for any errors.

6. Click Save.

7. Close Domain Editor.

The domain is now ready to be customized for your particular needs.

9.1.5 Classes and Tables and Subtables—What’s the 
Difference 

WebTAS end-users do not have to know the difference between classes, tables and 
subtables. WebTAS domain designers and domain administrators need to be aware 
of the distinctions.

9.1.5.1 Classes

A class maps to one or more WebTAS native database tables according to native 
database persistence rules and conventions. This mapping provides the storage for 
native database objects of the class, and also provides the plumbing that preserves 
class inheritance behavior during queries. If you want to add a data container to the 
WebTAS Default Data Source create a new class and add the attributes desired.

All classes configured for the WebTAS native database appear beneath the TAS 
Object class, listed in alphabetical order. 
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9.1.5.2 Tables

Classes in WebTAS usually refer to WebTAS Native (Default Data Source) 
content. A table maps to one table in a data source, most often external, but 
sometimes native. Tables can be queried just like classes, but do not exhibit 
inheritance behavior. 

Note
Tables are typically read-only, except in cases where 
custom modifiable data sources have been written.

Tables from external data sources are listed below their respective data sources. 
These lists of tables are available to the Domain Administrator when adding table 
attributes or when joining table attributes to classes.

9.1.5.3 Subtables

A subtable maps to one WebTAS native database table with a many-to-1 relation 
to one or more classes. Subtable rows with the same primary key of a class are 
"owned" by the class instance. Subtable rows are added or modified when the 
associated class instance is added or modified. Subtable rows are deleted when the 
associated class instance is deleted. 

9.1.5.4 Attributes

For database data sources, an attribute is typically mapped to one or more columns 
in the physical database table of the class, table or subtable. Attributes can also be 
configured as virtual or computed (advanced topics).
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Figure 9–3  Class and Subtable Associations

 Create a New Table

1. Open your new domain in the Domain Editor.

2. Select the Default Data Source.

3. Edit > New > Table. 

4. Enter the name of the table (Track Points).

5. Click OK.

Create a New Class

1. Select the TAS Object.

2. Edit > New > Class.

3. Enter the name of the Class (Track).

4. Click OK.
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9.1.6 Attributes

Attributes describe all the characteristics of classes. Attributes appear in the right 
pane of the Domain Editor for the selected object class. The icons differ according 
to the attribute type. For instance, if you have a class of aircraft, one attribute may 
be fuel load. You can add attributes to any native class within the WebTAS 
domain. For example, the airplane class has attributes of fuel load, number of 
bombs carried, and type.

Figure 9–4  Attribute Example

There are different attribute/data types within WebTAS. The Domain Editor 
manual provides a detailed definition of each data type. The specific attributes in a 
particular domain vary according to the nature of objects and how you want to 
manipulate them within WebTAS. 

The add attribute window can be reached via the menu Edit > New > Attribute, 
from the Toolbar or by right-clicking in the right pane.

Figure 9–5  Add Attribute

For a description of the tabs, see the Domain Editor manual.
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Create attributes for Table

1. Select the Table you created (Track Points).

2. Edit > New > Attribute.

3. Create an attribute named Point Date of type Date.

4. Create an attribute named Location of type Location.

5. Create an attribute named Point Type of type text and length 255.

Create attributes for Class

1. Select the Class you created (Track).

2. Edit > New > Attribute.

3. Create an attribute named Type of type Text and length 25.

4. Create an attribute named Origin Country of type Text and length 80.

5. Create an attribute named Destination Country of type Text and length 80.

6. Create an attribute named Suspect Cargo of type Text and length 80.

7. Create an attribute named Track Points of type Table and associated with the 
Track Point s table.

9.1.7 Picklists

Picklists are a type of attribute requiring additional steps to create. They are 
predefined lists of all available values for a particular attribute. Picklists constrict 
the choices for an attribute's value by specifying the values a user can select.

Create a Picklist

1. Select the Picklist folder and Edit > New > Picklist.
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Figure 9–6  Add Picklist

2. Enter name (Suspect Cargo) of picklist.

3. In the options field enter the value to be displayed (Cocaine) and click the 
Add button.

4. Perform Step 3 for Cocaine Base, HCL, Marijuana and Heroin.

5. Click OK.

Create a second Picklist named Track Type with the following values:

AIR, MER, NAV, UNK

Reorder you list to be UNK, AIR, MER, and NAV.

For a picklist to be available to the attribute, it must be linked to an attribute(s) 
using the Properties dialog. 

Associate a picklist to an attribute

1. Select the Track - Type attribute.

2. Right-click and select properties.

3. Select the Picklist tab and choose the Track Type picklist from the list.
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4. Click OK.

5. Select the Track - Suspect Cargo attribute.

6. Right-click and select properties.

7. Select the Picklist tab and choose the Suspect Cargo picklist from the list.

8. Click OK.

9.1.8 Units

Often when you are entering numeric information you must convert the value into 
the units required by the input field. WebTAS uses the units subsystem to perform 
these unit conversions for you. When you define a new unit category, you specify 
all the different units within that category you want to support, along with the 
conversion factors.

Suppose you want to support the entry of distances in nautical miles (nm), statute 
miles (sm), and kilometers (km). First, WebTAS requires you choose one of your 
units to be the base unit. The base unit is the unit the other units of the category 
will be converted to for storage in the WebTAS database. The choice of base unit 
is somewhat arbitrary, but the logical choice is the unit you would like to be the 
default when users enter data. Once you have selected the base unit, you specify 
the rest of the category's units along with their conversion factors to the base unit. 

For example:

Nautical miles as the base unit—Conversion factor is 1.0, since values entered in 
the base unit are stored in the base unit and values entered in another unit are 
converted into the base unit prior to being stored. 

Statute miles—Conversion factor to nautical miles is 0.86897624 (statute miles 
times 0.86897624 = nautical miles). 

Kilometers—Conversion factor to nautical miles is 0.5399568034 (kilometers 
times 0.5399568034 = nautical miles). 

When a new float attribute is created, you can select the appropriate unit category 
from the provided droplist. The droplist is created from the defined units. WebTAS 
converts the value to the base unit before storing the value in the database. 

Create a New Unit type

1. With the Unit folder selected, Edit > New > Unit Category or right-click in 
the right pane.

2. Name the Unit Category (Area) and click OK.



 
9 Using the Domain Editor

WebTAS Training v3.3.2 • 17 February 2009

9–15 
 

3. Select the new category and add a new unit.

4. Name the unit and (Acres) populate the conversion factor. (Start with a 
conversion factor of 1.0)

5. Click OK.

6. Repeat Steps 3 through 5 for Hectares.(One acre = 0.404685 hectares)

9.1.9 Mapping to another Database Schema 

For each database data source a folder named Database Schema is displayed. 
When expanded, this folder displays the database schema for the data source. It 
enables you to view the database tables and views in an external data source 
connected to WebTAS. This helps you map tables and columns to classes and 
attributes into the WebTAS domain from the external data source. 

9.1.9.1 Another View

You can view the schema as an HTML file by selecting View > View in HTML
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Figure 9–7  View in HTML

You can see more detail by clicking on the link of interest.
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Figure 9–8  Expanded View

9.1.10 External Data Sources

WebTAS can be connected to one or more external data sources to analyze 
information relevant to your site. External data sources provide the raw 
information WebTAS uses during information analysis. Data sources vary from 
site to site. 

WebTAS supports connections to a variety of typical external data sources such as 
MIDB, Oracle, Sybase, and Microsoft Access databases. Also, the system can be 
easily customized to support other unusual or unique data sources such as live 
satellite feeds. Adding an external data source entails configuring WebTAS and 
the operating system so WebTAS can read information from the data source. 

The first and most basic task when adding an external data source is configuring a 
connection between WebTAS and the desired data source.

Information about users, data sources, and data structures used by WebTAS is 
maintained in the data dictionary file. 

The specific steps required to add an external data source vary considerably 
depending on the type of data source and the details of the system/network 
configuration at hand. However, the process is fundamentally the same for all data 
sources. 

There are two basic types of connections between WebTAS and typical external 
data sources:

• Open DataBase Connectivity (ODBC) connection—Applies to data sources 
such as Microsoft Access or Excel, and is frequently used for systems where 
WebTAS is installed and run on a single machine.
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• Connection to a full-fledged relational database—Typically used when data 
sources are dedicated Oracle or Sybase database servers operating on a 
network with multiple WebTAS clients.

Note
Generally, WebTAS only reads information from external 
data sources; the only data source it writes back to is 
Modernized Integrated Database (MIDB).

Map an External Data Source Demo/Follow Along

1. Open your empty data dictionary in Domain Editor

2. Select Data Sources

3. Right-click in the blank area of the right pane

4. Select New > Data Source

5. Select Microsoft Access and click OK.

6. Provide a Name for the new data source (Ships)

7. Choose the Use ODBC File option

8. Click Choose, navigate to C:\WebTAS-UserSpace\temp

9. Open Maritime.mdb 

10. Test your connection, if successful click OK twice

11. Expand Ships and Database Schema

12. Select Vessel

13. Deselect All

14. Include the Following:

• Agent

• Flag 

• ID 

• Line

• Location Lat. and Long
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• Name

• Stevedore

• Type

15. Rename:

• Agent > Booking Agent

• Flag > Country

• Line > Shipping Company

16. Format Names

17. Rename your table to Ships

18. Click the Create button to create the Ships table

19. Select ID as the Primary Key

20. Click the Create button to create the Ships table

21. Save your data dictionary

22. Open Project Tool and Show Ships on a table and a map

Create a Location Attribute

1. Open the Domain Editor and select the Ships Table

2. Right-click in the blank area of the right pane

3. Select New > Location Attribute

4. Name the attribute Location

5. Select the appropriate Latitude and Longitude

6. Click OK

7. Save the data dictionary.

8. Open Project Tool and Show Ships on a table and a map

9.1.11 SNL Driven Picklists

If you want the options and values contained in a picklist to be dependent on the 
values in a data source you can create a picklist using the SNL Driven option.



 
9 Using the Domain Editor 
WebTAS Training v3.3.2 • 17 February 2009 

9–20 
 

CREATE AN SNL DRIVEN PICKLIST

1. Re-open Domain Editor to your new domain if needed.

2. Create a picklist category called Stevedore Company.

3. Select the SNL driven picklist option.
The create picklist dialog opens.

Figure 9–9  SNL Driven Picklist

4. Click the Edit button.

5. Select Ships and click the Accept button.

6. Set Value, Option and Order By to Stevedore.

7. Click Ok.

8. Add an attribute to Track called Stevedore Test
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9. Associate the Stevedore Test Attribute with the Stevedore Company picklist.

10. View Track in the GUI tab.

11. Click test GUI and view the Stevedore Test field droplist.

9.2 Joins

The Domain Editor enables you to define several different types of relational joins. Joins 
enable you to combine data in ways that would not be possible across all data sources 
defined in a domain. You can join classes and tables seamlessly in any combination 
desired. 

The two main categories of joins available within WebTAS—user interface and 
domain—are defined within the WebTAS domain using the Domain Editor. 

A user interface join, known as a Selection Join links data on data displays within the 
Project Tool. Selection joins are currently just a visual/display mechanism. If both 
Object Types are displayed, clicking one should highlight the other where the criteria is 
met. There aren't any query or DataObject building uses for selection joins.

The other two types are database joins linking data within the WebTAS domain. The 
following list explains the join options available within the Domain Editor. 

•  New Join—Performs a one-to-one join between classes/tables within the 
WebTAS domain. If there is more than one correlation between matched pairs, 
only the first correlation is returned. WebTAS will let the database perform this 
operation when applicable.

•  New Selection Join—Performs a user interface join between data attributes 
in Project Tool displays at runtime. Correlates one or many rows in two 
displays. 

•  New Table Join—Performs a one-to-many join between classes/tables within 
the WebTAS domain. WebTAS will let the database perform this operation 
when applicable.

You can define joins between any two classes or tables in a WebTAS domain.
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Figure 9–10  Join Dialog

• Join is Required Entry—When selected, the field cannot contain a null 
value.

• Show on Add/Modify Dialogs—When selected, whatever information is 
shared between the two classes is displayed. You cannot modify attributes from 
one class to another.

• (Add Join Only) Always Join—Join is always added to the SQL to force 
correct querying. The code generates an SQL inner join here since there MUST 
be rows on both sides of the join in this situation.

• Perform INNER Join—Inner join syntax is used instead of left outer join, 
the default. This pertains to joins and table joins.

• Display as Relationship—creates a relationship instead of joining the 
objects.
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o Relationship Label—displays the label for the standard relationship.

o Inverse Label—displays the label for the inverse of the relationship.

EXERCISE: CREATE A JOIN BETWEEN DEFAULT AND EXTERNAL DATA 
SOURCES 

You will use the domain CIDNE_WEBTAS_UNCLASS.wtdd for this exercise. This data 
dictionary uses accesscolombiademo.mdb as the default data source and CIDNE.mdb as 
the external data source. The CIDNE database is a conversion from the CIDNE SQL 
database running in IRAQ. 

1. Open CIDNE_WEBTAS_UNCLASS.wtdd in Domain Editor 

2. In Domain Editor create a new class under TAS Object called “Incident 
Reports”
Create the following attributes:

• Category

o Type Text

o Length 10

• Tower Number

o Type Integer

o Min. = 0; Max = 10

• Summary

o Type Text

o Length 255

3. In Domain Editor map the CIDNE Towers table to a table named Towers.

4. Create a Tower Location Attribute

5. Update Security Manager to reflect proper permissions for the Towers table

6. Open CIDNE_WEBTAS_UNCLASS.wtdd in Project Tool
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7. Populate the Incident Report Records with the following data:

8. Query Incident reports to New Table, ensure your changes appear

9. Query Incident reports to New Map.

10. Query Towers to a New Table, no records should exist

11. Close Project Tool

12. Open Domain Editor and create a JOIN from Incident Reports to TOWERS

• Tower Number > Number

13. Re-open Project Tool, query Incident Reports to a New Table.

14. Query Incident Reports to a New Map.

15. Repeat steps 12 through 14 using a table join, notice the difference in how the 
data is displayed when querying Incident Reports to a table.

9.3 Undoing Changes 

Saved changes cannot be undone. If you decide you do not want to implement changes 
you have made since your last save, exit out of Domain Editor without saving the 
changes by clicking No in the Save changes (Y/N)? window. 

Table 9–1  

Category Tower Number Summary

Radio 1 KKFM

TV 2 KKTV

Radio 3 KCME

TV 4 KOAA
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9.4 Queryable Objects

 The Queryable Objects folder contains items that can be queried from within the Query 
Panel (Web and Project Tool). If you do not care to configure queryable objects, 
WebTAS will do it for you automatically.

Add items to a queryable folder

1. Open accesscolombiademo.wtdd in Domain Editor

2. Expand the Data Sources to show the TAS Object Classes

3. Add the following to Queryable Objects

o Events

o Organizations

o Place

o Imagery

o Guerrilla Units

o Government Units

o Members

4. Select the Queryable Objects Folder and create a new folder called Opposing 
Forces

5. Move Organizations, Guerrilla Units, and Government Units into the new 
folder

6. Delete TAS object from Queryable Objects

7. Save and exit Domain Editor

8. Open Project Tool and view the objects available to be queried.
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